Symantec NetBackup™ for Microsoft SharePoint Server Administrator’s Guide

for Windows

Release 7.5
Symantec NetBackup™ for Microsoft SharePoint Server
Administrator’s Guide

The software described in this book is furnished under a license agreement and may be used only in accordance with the terms of the agreement.

Documentation version: 7.5

Legal Notice

Copyright © 2012 Symantec Corporation. All rights reserved.

Symantec, Veritas, NetBackup and the Symantec Logo are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party (“Third Party Programs”). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

Portions of this software are derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright 1991-92, RSA Data Security, Inc. Created 1991. All rights reserved.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, "Rights in Commercial Computer Software or Commercial Computer Software Documentation", as applicable, and any successor regulations. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount of service for any size organization
■ Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
■ Upgrade assurance that delivers software upgrades
■ Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

■ Product release level
Hardware information
Available memory, disk space, and NIC information
Operating system
Version and patch level
Network topology
Router, gateway, and IP address information
Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:
www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:
www.symantec.com/business/support/
Customer Service is available to assist with non-technical questions, such as the following types of issues:
  - Questions regarding product licensing or serialization
  - Product registration updates, such as address or name changes
  - General product information (features, language availability, local dealers)
  - Latest information about product updates and upgrades
  - Information about upgrade assurance and support contracts
  - Information about the Symantec Buying Programs
  - Advice about Symantec's technical support options
  - Nontechnical presales questions
  - Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan          customercare_apac@symantec.com
Europe, Middle-East, and Africa  seMEA@Symantec.com
North America and Latin America  supportSolutions@Symantec.com
Configuring restores for a SharePoint farm with multiple servers .............................................................. 58
Testing configuration settings for NetBackup for SharePoint .............................................................. 58

Chapter 5 Configuring NetBackup for SharePoint backup policies ......................................................... 61

About backup policies for granular backup and recovery of SharePoint Server .................................................. 61
About backup policies for SharePoint farm backup and recovery ...................................................... 62
About backup policies for disaster recovery of SharePoint Server .................................................. 63
About VMware backup policies that protect SharePoint Server ..................................................... 64
About configuring a backup policy for a SharePoint database ................................................... 65
Adding a new NetBackup for SharePoint policy .............................................................. 65
About policy attributes for NetBackup for SharePoint .......................................................... 66
Adding schedules to a NetBackup for SharePoint policy .......................................................... 67
Adding clients to a NetBackup for SharePoint policy ........................................................... 72
Creating a backup selections list for a SharePoint Server policy .................................................. 72

Chapter 6 Performing backups and restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services ................................................. 75

About NetBackup for SharePoint Server backup and restores ..................................................... 75
About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services ......................................................... 76
Specifying the server and client for a SharePoint Server backup operation .............................................. 77
About backup options for NetBackup for SharePoint ................................................................ 77
Performing a user-directed backup of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services ........................................................................... 78
About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services ......................................................... 79
Specifying the server, client, and the policy type for a SharePoint Server restore operation ......................................................... 80
Restore options for SharePoint Server ...................................................................... 80
How the NetBackup Recovery Assistant restores SharePoint Server, SharePoint Foundation, and Windows SharePoint Services ................................................. 84
Restoring SharePoint Server, SharePoint Foundation, or Windows

Restoring SharePoint Services .......................................................... 85
Restoring the SharePoint 2010 Search Service Application ............. 89
Restoring the SharePoint 2007 Shared Services Provider ............... 91
About requirements for restores of individual SharePoint items
using Granular Recovery Technology (GRT) .......................... 94
Restoring individual SharePoint items from full database
backups ............................................................................. 95
Recovering a SharePoint Web application in a farm with multiple
front-end servers (SharePoint 2007 or later) ................................ 100
Restoring a deleted SharePoint list ........................................ 102
Redirecting a restore of a SharePoint Web application within a
farm ............................................................................. 106
Redirecting a restore of a SharePoint Web application to another
farm ............................................................................. 109
Redirecting individual SharePoint items to a file path ................. 112

Chapter 7 Protecting SharePoint Server data with VMware backups .......................................................... 115
About protecting SharePoint Server data with VMware backups ........ 115
Limitations of using a VMware policy to protect SharePoint
Server .................................................................................. 116
Support for VMware backups that protect SharePoint Server ............ 117
About configuring NetBackup for VMware backups that protect
SharePoint Server .................................................................... 117
Configuring for Granular Recovery Technology (GRT) with a
VMware backup that protects SharePoint Server .................. 118
Configuring a VMware backup policy for SharePoint Server
................................................................................... 119
Configuring the granular proxy for Federated SharePoint
configurations ............................................................... 120
Restoring SharePoint data from a VMware backup ..................... 120

Chapter 8 Disaster recovery .......................................................... 123
About disaster recovery of a SharePoint Server .......................... 123
Requirements for disaster recovery of a SharePoint Server ............ 123
Recovering a SharePoint 2010 Server (without BMR) ................... 124
Recovering a SharePoint 2007 Server (without BMR) ................... 125
Chapter 9  Troubleshooting ................................................................. 127
  About NetBackup for SharePoint debug logging ............................ 127
  Enabling the debug logs for a NetBackup for SharePoint client
  automatically ........................................................................ 128
  Enabling the debug logging for NetBackup for SharePoint
  manually ............................................................................... 128
  Setting the debug level on a NetBackup for SharePoint Windows
  client .................................................................................. 129
  About NetBackup status reports ................................................ 130
  Viewing the progress report of a NetBackup for SharePoint
  operation ............................................................................. 130
  Troubleshooting SharePoint jobs that use Granular Recovery
  Technology (GRT) .................................................................. 131
  About troubleshooting SharePoint restore operations ................... 131
  About NetBackup for SharePoint and client-side deduplication ....... 132
  Troubleshooting VMware backups and restores of SharePoint
  Server .................................................................................. 133

Chapter 10  Using NetBackup for SharePoint with SharePoint
  Server 2003 ........................................................................... 135
  Limitations on SharePoint Server 2003 restores .......................... 135
  About restores of SharePoint Server 2003 and Windows SharePoint
  Services 2.0 .......................................................................... 136
  How the NetBackup Recovery Assistant restores SharePoint
  Server 2003 and Windows SharePoint Services 2.0 ................. 136
  Restore options for SharePoint Server 2003 on the Microsoft
  SharePoint tab ............................................................... 137
  Redirecting a restore of a SharePoint 2003 portal site or team
  site .................................................................................... 140
  Recovering SharePoint 2003 Server (without BMR) .................... 141

Index ...................................................................................... 143
Introducing NetBackup for SharePoint Server

This chapter includes the following topics:

- About NetBackup for SharePoint Server
- About NetBackup for SharePoint features
- SharePoint Server backup operations
- About the contents of a SharePoint Server 2010 and SharePoint Foundation 2010 backup
- About the contents of a SharePoint Server 2007 and Windows SharePoint Services 3.0 backup
- SharePoint Server restore operations
- Limitations on SharePoint Server backups and restores
- NetBackup File System Daemon
- NetBackup documentation

About NetBackup for SharePoint Server

NetBackup for SharePoint extends the capabilities of NetBackup to include online backups and restores SharePoint Server. The NetBackup agent for Microsoft SharePoint Server is an optional, add-on component to the NetBackup for Windows client software. Because this product is tightly integrated with the Backup, Archive, and Restore interface, this manual provides only an overview of NetBackup functionality. Backup operations and restore operations for SharePoint Server are identical to other NetBackup file operations, except where noted.
Microsoft SharePoint Server, Microsoft Office SharePoint Server, or Microsoft SharePoint Portal Server may be abbreviated to either SharePoint Server or to SharePoint. Unless otherwise noted, the text implies SharePoint Foundation or Windows SharePoint Services when SharePoint is discussed.

About NetBackup for SharePoint features

Table 1-1 describes the features for the NetBackup for SharePoint Agent.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online backup</td>
<td>SharePoint Server objects can be backed up without taking the SharePoint Server offline. SharePoint services and data are available during the backup.</td>
</tr>
<tr>
<td>SharePoint Server backup</td>
<td>NetBackup supports full and differential-incremental backups of SharePoint.</td>
</tr>
<tr>
<td>methods</td>
<td></td>
</tr>
<tr>
<td>Tight NetBackup integration</td>
<td>Tight integration with NetBackup means the following:</td>
</tr>
<tr>
<td></td>
<td>■ An administrator already familiar with NetBackup procedures and software can easily configure and use NetBackup to perform SharePoint Server backup and restore operations.</td>
</tr>
<tr>
<td></td>
<td>■ Features and strengths of the NetBackup product suite are available to the SharePoint Server backup user. These features include scheduled and user-directed operations and in-line tape copy. These features are described in detail.</td>
</tr>
<tr>
<td></td>
<td>See the NetBackup Administrator’s Guide, Volume I.</td>
</tr>
<tr>
<td>Central administration</td>
<td>You can administer the backup and recovery of multiple SharePoint Server installations from a central location.</td>
</tr>
<tr>
<td>Media management</td>
<td>SharePoint Server backups are saved directly to a wide variety of storage devices that NetBackup supports.</td>
</tr>
<tr>
<td>Automated backups</td>
<td>Administrators can set up schedules for automatic, unattended backups for local or remote clients across the network. These backups are managed entirely by the NetBackup server from a central location. The administrator can also manually back up the clients. Auto discovery is used for SharePoint Server installations. The topology is read from the SharePoint front-end Web server and the backup selection list is automatically built.</td>
</tr>
<tr>
<td></td>
<td>See “About the contents of a SharePoint Server 2010 and SharePoint Foundation 2010 backup” on page 16.</td>
</tr>
<tr>
<td></td>
<td>See “About the contents of a SharePoint Server 2007 and Windows SharePoint Services 3.0 backup” on page 18.</td>
</tr>
<tr>
<td>User-directed backups</td>
<td>A user can perform backups of SharePoint Server resources through the Backup, Archive, and Restore client interface on the front-end Web server.</td>
</tr>
</tbody>
</table>
### Table 1-1 NetBackup for SharePoint Agent features (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backups and restores of standalone SharePoint Foundation or Windows SharePoint Services (WSS)</td>
<td>NetBackup can back up and restore standalone installations of SharePoint Foundation or Windows SharePoint Services.</td>
</tr>
<tr>
<td>Support for VMware backups that protect SharePoint</td>
<td>VMware backups that protect SharePoint Server provide granular recovery, complete protection of the farm, and protection of the SharePoint components in the Windows files system.</td>
</tr>
<tr>
<td>Compression of backups</td>
<td>Compression increases backup performance over the network and reduces the size of the backup image that is stored on the disk or tape. NetBackup does not support compression of the backups that use Granular Recovery Technology.</td>
</tr>
<tr>
<td>Encryption</td>
<td>When the Encryption attribute is enabled, the server encrypts the backup for the clients that are listed in the policy. NetBackup does not support encryption of any backups that use GRT.</td>
</tr>
<tr>
<td>Restore operations</td>
<td>An administrator who uses the Backup, Archive, and Restore interface can browse SharePoint Server backups and select the ones to restore.</td>
</tr>
<tr>
<td>Restores of individual items and document sets using Granular Recovery Technology (GRT)</td>
<td>When a backup uses GRT, users can restore individual items and documents sets directly from any full database backup of a Web application. This feature adds an extra step that identifies the items within the database. This step lets you recover individual items later. (Note that you must create a separate backup for the full farm.)</td>
</tr>
</tbody>
</table>
| Redirected restore | You can redirect the restore of the following:  
  - SharePoint Web application within a farm.  
  - SharePoint Web application to another farm.  
  - Individual SharePoint documents and pictures to a file path on the same site. |
| Support for any backups that were created with previous NetBackup versions | You can restore the backups that were created with versions of NetBackup before 6.5.4. However, new 6.5.4 and later features are not supported with any backups that were created with previous versions. For example, you cannot restore list items from a NetBackup 6.5.3 or earlier backup. |


See “Planning the installation of NetBackup for SharePoint ” on page 23.

See “NetBackup server and client requirements for NetBackup for SharePoint” on page 24.

See “About installing and configuring Network File System (NFS) for SharePoint Granular Recovery” on page 27.
See “About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 76.

SharePoint Server backup operations

You can use the NetBackup for SharePoint Server agent to back up the entire SharePoint Server farm or individual components. NetBackup provides the following methods to perform backups:

- Automatic
- Manual
- User-directed

For general information on backup methods in NetBackup see the *NetBackup Administrator’s Guide, Volume I*.

The NetBackup administrator can schedule the backups that occur automatically and unattended under the control of the NetBackup Server. The following types of automatic backups are available:

Full schedule  
The entire contents in the backup selections list are backed up.

Differential incremental  
Only the contents that have been added or changed since the previous full or incremental are included in the backup.

Manual backup may be used for special events. A manual backup includes all the items in the backup selections list of the policy you selected for backup.

User directed backups require a User Backup schedule to be defined on a SharePoint policy on the NetBackup Server. A user-directed backup includes the entire contents of the items that are selected for backup. This type of backup is only supported from the SharePoint application host, not on other hosts where only SharePoint objects are present.

About the contents of a SharePoint Server 2010 and SharePoint Foundation 2010 backup

SharePoint 2010 offers new metadata features including tags, social bookmarks, and content ratings. These new types of metadata are stored in the service applications that reside outside of the content database. For example, content ratings reside in the Managed Metadata Service application. You can also create
custom service applications and store metadata in them. You should make sure to back up all of your service applications to ensure that all metadata is protected.

Since metadata is stored outside of the content database, it cannot be restored using Granular Recovery Technology (GRT). You can, however, use GRT to restore SharePoint data with metadata attached to it. As long as the metadata resides in the same service application, SharePoint maintains the link between the two items.

Table 1-2 lists the SharePoint Server farm or the SharePoint Foundation components that you can back up and restore with NetBackup for SharePoint.

<table>
<thead>
<tr>
<th>SharePoint Server 2010 and SharePoint Foundation 2010 components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration database</td>
</tr>
<tr>
<td>InfoPath Forms Services</td>
</tr>
<tr>
<td>SharePoint Server State Service</td>
</tr>
<tr>
<td>Microsoft SharePoint Foundation Web Application</td>
</tr>
<tr>
<td>WSS Administration</td>
</tr>
<tr>
<td>SharePoint Server State Service Proxy</td>
</tr>
<tr>
<td>SPUUserCodeV4</td>
</tr>
<tr>
<td>Microsoft SharePoint Server Diagnostics Service</td>
</tr>
<tr>
<td>Global Search Settings</td>
</tr>
<tr>
<td>SharePoint Foundation Help Search</td>
</tr>
</tbody>
</table>
### Table 1-2

**SharePoint Server 2010 and SharePoint Foundation 2010 components (continued)**

<table>
<thead>
<tr>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared Services:</td>
</tr>
<tr>
<td>■ Shared Service Applications</td>
</tr>
<tr>
<td>■ Access Services</td>
</tr>
<tr>
<td>■ Secure Store Service</td>
</tr>
<tr>
<td>■ PerformancePoint Service Application</td>
</tr>
<tr>
<td>■ Visio Graphics Service</td>
</tr>
<tr>
<td>■ Managed Metadata Service</td>
</tr>
<tr>
<td>■ Excel Services Application</td>
</tr>
<tr>
<td>■ Security TokenService Application</td>
</tr>
<tr>
<td>■ Word Automation Services</td>
</tr>
<tr>
<td>■ User Profile Service Application</td>
</tr>
<tr>
<td>■ Business Data Connectivity Service</td>
</tr>
<tr>
<td>■ Search Service Application</td>
</tr>
<tr>
<td>■ Shared Services Proxies</td>
</tr>
<tr>
<td>■ Business Data Connectivity Service</td>
</tr>
<tr>
<td>■ Word Automation Services</td>
</tr>
<tr>
<td>■ Managed Metadata Service</td>
</tr>
<tr>
<td>■ PerformancePoint Service Application</td>
</tr>
<tr>
<td>■ Secure Store Service</td>
</tr>
<tr>
<td>■ Search Service Application</td>
</tr>
<tr>
<td>■ Web Analytics Service Application</td>
</tr>
<tr>
<td>■ User Profile Service Application</td>
</tr>
<tr>
<td>■ Visio Graphics Service</td>
</tr>
</tbody>
</table>

See “About NetBackup for SharePoint features” on page 14.


---

### About the contents of a SharePoint Server 2007 and Windows SharePoint Services 3.0 backup

**Table 1-3** lists the SharePoint Server farm components or Windows SharePoint Services that you can back up and restore with NetBackup for SharePoint.
### Table 1-3  Comparison of SharePoint Server 2007 and Windows SharePoint Services 3.0 components

<table>
<thead>
<tr>
<th><strong>SharePoint Server 2007 farm</strong></th>
<th><strong>Windows SharePoint Services</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration database</td>
<td>Configuration database</td>
</tr>
<tr>
<td>Global settings</td>
<td></td>
</tr>
<tr>
<td>Single Sign-on database</td>
<td></td>
</tr>
<tr>
<td>Shared Services:</td>
<td>WSS Help Search:</td>
</tr>
<tr>
<td>■ Services database</td>
<td>■ Index files</td>
</tr>
<tr>
<td>■ Shared Search Index</td>
<td>■ Search database</td>
</tr>
<tr>
<td>■ Index files</td>
<td></td>
</tr>
<tr>
<td>■ Search database</td>
<td></td>
</tr>
<tr>
<td>■ Web application</td>
<td></td>
</tr>
<tr>
<td>■ Content database</td>
<td></td>
</tr>
<tr>
<td>Web application</td>
<td>WSS Administration:</td>
</tr>
<tr>
<td></td>
<td>■ Web application</td>
</tr>
<tr>
<td></td>
<td>■ Content database</td>
</tr>
</tbody>
</table>

### SharePoint Server restore operations

Use the Backup, Archive, and Restore interface to initiate SharePoint Server restore operations. This interface lets you select the NetBackup Server from which the objects are restored and the client whose backups you want to browse. Based upon these selections, you can browse the backup history, select individual items and launch a restore. The NetBackup Recovery Assistant lets you restore SharePoint resources with one click and determines the sequence in which the resources are restored.

An administrator can browse for and restore databases and individual items. Users also can restore the security settings on a selected item. Objects that users can restore include the following:

- One or more databases
- Individual documents in a Document library
- Entire sites
- Subsites
- Entire lists or libraries
Limitations on SharePoint Server backups and restores

The following limitations exist when you perform backups and restores of SharePoint Server:

- The following cannot be redirected to another Web application:
  - Documents and folders (These items can be redirected to a file system.)
  - Farm Configuration database and Single Sign-on database
  - Index Files or Index database
- SharePoint policies do not support multiple data streams.
- If you perform a restore of a SharePoint 2010 item with Granular Recovery Technology (GRT), any SharePoint 2010 user ratings and tags are synchronized to the current settings of the user rating and tags in the respective metadata databases.
- Due to Microsoft API limitations, NetBackup does not support backups of the Application Registry service application.
- Project Server databases are not protected.
- Backups with GRT do not support any content databases that exist on multiple servers in a farm.

NetBackup File System Daemon

The NetBackup File System Daemon (NBFSD) on the NetBackup media server is a process that allows NetBackup clients to mount, browse, and read tar images. This process is used with a client for Granular Recovery Technology (GRT) operations. These operations include backups, browsing for backup images, restores, and duplication.
NetBackup documentation

NetBackup documentation is part of the NetBackup media kit and can be found in a directory on the installation DVD for each release platform.


For a complete list of NetBackup technical documents, see the Related Documents appendix in the NetBackup Release Notes.

The Symantec support Web site contains links to the most recent documentation plus a list of helpful how-to and product alert topics.

This chapter includes the following topics:

- Planning the installation of NetBackup for SharePoint
- Verifying the operating system and platform compatibility for NetBackup for SharePoint
- NetBackup server and client requirements for NetBackup for SharePoint
- SharePoint server software requirements for NetBackup for SharePoint
- Requirements for installing the SQL back-end servers in a cluster
- Adding license keys for NetBackup for SharePoint backups

Planning the installation of NetBackup for SharePoint

Perform the following tasks before you use NetBackup for SharePoint.

Table 2-1  Installation steps for NetBackup for SharePoint

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Verify the operating system and platform compatibility.</td>
<td>See “Verifying the operating system and platform compatibility for NetBackup for SharePoint” on page 24.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Verify the NetBackup server and client requirements for NetBackup for SharePoint.</td>
<td>See “NetBackup server and client requirements for NetBackup for SharePoint” on page 24.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Verify the SharePoint software requirements for NetBackup for SharePoint.</td>
<td>See “SharePoint server software requirements for NetBackup for SharePoint” on page 25.</td>
</tr>
</tbody>
</table>
Table 2-1  
Installation steps for NetBackup for SharePoint (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Add the applicable license key(s) to the master server.</td>
<td>See “Adding license keys for NetBackup for SharePoint backups” on page 26.</td>
</tr>
</tbody>
</table>

Verifying the operating system and platform compatibility for NetBackup for SharePoint

Verify that the NetBackup for SharePoint agent is supported on your operating system or platform.

To verify operating system and compatibility

1. Go to the Symantec Support Web page:
   "http://www.symantec.com/business/support/index.jsp"
2. Click on the link for NetBackup Enterprise Server.
3. In the list of documents, click on the following document:
   "NetBackup Database Agent Compatibility List"
4. For information on support for VMware, see the following document:
   "Statement of Support for NetBackup in a Virtual Environment (Virtualization Technologies)"

NetBackup server and client requirements for NetBackup for SharePoint

Verify that the following requirements are met for the NetBackup server:

- The NetBackup server software is installed and operational on the NetBackup server. The NetBackup server platform can be any that NetBackup supports. See the NetBackup Installation Guide.
- Make sure that you configure any backup media that the storage unit uses. The number of media volumes that are required depends on several things:
  - The devices used
  - The sizes of the databases that you want to back up
  - The amount of data that you want to archive
  - The size of your backups
The frequency of backups or archives
See the NetBackup Administrator’s Guide, Volume I.

Verify that the following requirements are met for the NetBackup clients:

- The NetBackup client software is installed on all SharePoint servers, except
  the Search server or Job server. In a VMware environment, the NetBackup
  client software must be installed on the virtual machines that are part of a
  SharePoint farm.
- To use the new features that are included in NetBackup for SharePoint in
  NetBackup 7.5 or later releases, you must upgrade your NetBackup for
  SharePoint clients. The media server and NetBackup for SharePoint clients
  must be at the same NetBackup version.

SharePoint server software requirements for NetBackup for SharePoint

Verify the following regarding the SharePoint server software on the NetBackup
server or client:

- SharePoint server software must be installed and operational.
- For SharePoint 2010, SharePoint 2007, and earlier, the Microsoft .NET
  Framework 3.5 is installed on the SharePoint servers.
- When you use multiple front-end SharePoint servers, all front-end server Web
  sites must be uniformly identified in IIS. Identify the sites with either host
  headers or IP addresses, but not both. An environment that mixes host headers
  and IP addresses across multiple front-end servers is not supported.
- To prevent restore failures, the IIS Default Application Pool identity must be
  a valid SharePoint user ID.
- The SharePoint user should be an administrator user account.

Requirements for installing the SQL back-end servers in a cluster

NetBackup supports clustering of a back-end SQL Server in a Veritas Cluster
Server (VCS) or a Microsoft Cluster Server (MSCS) environment.

For more information, see your VCS or your MSCS documentation.
Adding license keys for NetBackup for SharePoint backups

To use NetBackup for SharePoint, add a valid license key for it on the master server. More information is available on how to add license keys.

See the NetBackup Administrator’s Guide, Volume I.

To add a NetBackup for SharePoint license key in the NetBackup Administration Console

1 On the master server, open the NetBackup Administration Console.
2 Choose Help > License Keys.
3 Click the New icon.
4 Type the license key and click Add.
Installing and configuring NFS for SharePoint Granular Recovery

This chapter includes the following topics:

■ About installing and configuring Network File System (NFS) for SharePoint Granular Recovery

■ Requirements for SharePoint Granular Recovery

■ Configurations that are supported for SharePoint Granular Recovery

■ About configuring Services for Network File System (NFS) on the Windows 2008 and Windows 2008 R2 NetBackup media server and NetBackup clients

■ About configuring Services for Network File System (NFS) on the Windows 2003 R2 SP2 NetBackup media server and NetBackup clients

■ Configuring a UNIX or Linux media server and Windows clients for backups and restores that use Granular Recovery Technology

■ Configuring a different network port for NBFS

About installing and configuring Network File System (NFS) for SharePoint Granular Recovery

NetBackup Granular Recovery leverages Network File System, or NFS, to read individual objects from a database backup image. Specifically, the NetBackup client uses NFS to extract data from the backup image on the NetBackup media server. The NetBackup client uses “Client for NFS” to mount and access a mapped...
drive that is connected to the NetBackup media server. The NetBackup media server handles the I/O requests from the client through NBFS.

NBFS is the NetBackup File System (NBFS) service that runs on the media server. NBFS makes a NetBackup backup image appear as a file system folder to the NetBackup client over a secure connection.

Network File System, or NFS, is a widely recognized, open standard for client and server file access over a network. It allows clients to access files on dissimilar servers through a shared TCP/IP network. NFS is typically bundled with the host operating system. NetBackup uses Granular Recovery Technology (GRT) and NFS to recover the individual objects that reside within a database backup image, such as:

- A user account from an Active Directory database backup
- Email messages or folders from an Exchange database backup
- A document from a SharePoint database backup

Multiple NetBackup agents that support GRT (for example, Exchange, SharePoint, and Active Directory) can use the same media server.

**Note:** If you do not correctly configure NFS, restores of individual items using GRT fail with an error 223 (An invalid entry was encountered).

### Requirements for SharePoint Granular Recovery

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>You have a supported SharePoint Server configuration.</td>
<td>See the <em>NetBackup Database Agent Compatibility List</em>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>You have a media server platform that supports GRT.</td>
<td>See the <em>NetBackup Operating System Compatibility List</em>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>On all SQL back-end servers and the media server, ensure that the computer has an available drive letter on which to mount the backup image.</td>
<td></td>
</tr>
</tbody>
</table>
Table 3-1 Requirements for SharePoint Granular Recovery (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
  ■ Windows 2008 and Windows 2008 R2 media server and clients  
  ■ Windows 2003 R2 SP2 media server and clients  
  ■ UNIX/Linux media server and Windows clients |

Configurations that are supported for SharePoint Granular Recovery

For information on the SharePoint and SQL Server back-end versions and the Windows Server releases that are supported for Granular Recovery Technology (GRT) see the following:

NetBackup Database Agent Compatibility List

For information on the media server platforms that are supported for Granular Recovery Technology (GRT) see the following:

NetBackup Operating System Compatibility List

About configuring Services for Network File System (NFS) on the Windows 2008 and Windows 2008 R2 NetBackup media server and NetBackup clients

Note: For VMware backups and restores of SharePoint, the only systems that require configuration of NFS are the following: the systems that you use to browse for backups or the systems you use to perform restores. This configuration is not needed to capture the data during backups of the virtual machine.
### Table 3-2 Configuring NFS in a Windows 2008 or Windows 2008 R2 environment

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Stop and disable the Portmapper service.</td>
<td>Before you configure NFS on the media server or client(s), look for the ONC Portmapper service. If it exists, stop it and disable it. Otherwise, the configuration of NFS Services for Windows fails.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enable NFS.</td>
<td>Enable NFS on the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The NetBackup media server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The SQL back-end servers</td>
</tr>
<tr>
<td>Step 3</td>
<td>Install the hotfix for Client for NFS</td>
<td>On the SQL back-end servers, install the hotfix for Client for NFS. The hotfix is available at the following location:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://support.microsoft.com/kb/955012">http://support.microsoft.com/kb/955012</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Important Windows Vista hotfixes and Windows Server 2008 hotfixes are included in the same packages. However, the hotfix request page lists only Windows Vista. To request the hotfix package that applies to one or both operating systems, select the hotfix that is listed under Windows Vista on the page. Always refer to the Applies To section in articles to determine the actual operating system for each hotfix.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Disable Server for NFS.</td>
<td>You can disable the Server for NFS on the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The NetBackup media server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The SQL back-end servers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Disabling the Server for NFS” on page 35.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Disable Client for NFS.</td>
<td>You can disable the Client for NFS on the NetBackup media server. See “Disabling the Client for NFS on the media server” on page 34. If the SQL back-end server resides on the media server, do not disable the Client for NFS.</td>
</tr>
</tbody>
</table>

### Enabling Services for Network File System (NFS) on Windows 2008 or Windows 2008 R2

To restore individual items from a backup that uses Granular Recovery Technology (GRT), you must enable Services for Network File System. When this configuration is completed on the media server and the SQL back-end servers, you can disable any unnecessary NFS services.
To enable Services for Network File System (NFS) on Windows 2008 or Windows 2008 R2

1. Open the Server Manager.
2. In the left pane, click Roles and, in the right pane, click Add Roles.

3. In the Add Roles Wizard, on the Before You Begin page, click Next.
4 On the Select Server Roles page, under Roles, check the File Services check box.

<table>
<thead>
<tr>
<th>Select Server Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Services</strong></td>
</tr>
<tr>
<td><strong>Role Services</strong></td>
</tr>
<tr>
<td><strong>Confirmation</strong></td>
</tr>
<tr>
<td><strong>Progress</strong></td>
</tr>
<tr>
<td><strong>Results</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory Certificate Services</td>
<td></td>
</tr>
<tr>
<td>Active Directory Domain Services</td>
<td></td>
</tr>
<tr>
<td>Active Directory Federation Services</td>
<td></td>
</tr>
<tr>
<td>Active Directory Lightweight Directory Services</td>
<td></td>
</tr>
<tr>
<td>Active Directory Rights Management Services</td>
<td></td>
</tr>
<tr>
<td>Application Server</td>
<td></td>
</tr>
<tr>
<td>DHCP Server</td>
<td></td>
</tr>
<tr>
<td>DNS Server</td>
<td></td>
</tr>
<tr>
<td>Fax Server</td>
<td></td>
</tr>
</tbody>
</table>
| **File Services** | File services provides technologies that help you manage storage, enable file replication, manage shared folders, ensure fast file searching, and enable access for UNIX client computers.
| Hyper-V (Installed) | |
| Network Policy and Access Services | |
| Print Services | |
| Terminal Services | |
| UDDI Services | |
| Web Server (IIS) | |
| Windows Deployment Services | |
| Windows Server Update Services | |

5 Click Next.

6 On the Files Services page, click Next.

7 On the Select Role Services page, uncheck File Server.
8 Check Services for Network File System.

9 Click **Next** and complete the wizard.

10 On the media server, configure the portmap service to start automatically at server restart.

   Issue the following from the command prompt:

   ```
   sc config portmap start= auto
   ```

   This command should return the status output: `ChangeServiceConfig SUCCESS`.

11 For each host in your configuration, choose from one of the following:

   - If you have a single host that functions as both the media server and the SQL back-end server, you can disable the Server for NFS.

   - For a host that is only the NetBackup media server, you can disable the Server for NFS and the Client for NFS.
For a host that is only a SQL back-end server, you can disable the Server for NFS.

Disabling the Client for NFS on the media server

After you enable Services for Network File System (NFS) on a host that is only a NetBackup media server, you can disable the Client for NFS.

To disable the Client for NFS on the NetBackup media server

1. Open the Server Manager.
2. In the left pane, expand Configuration.
3. Click Services.
4. In the right pane, right-click on Client for NFS and click Stop.
5. In the right pane, right-click on Client for NFS and click Properties.
In the **Client for NFS Properties** dialog box, from the **Startup type** list, click **Disabled**.

Click **OK**.

**Disabling the Server for NFS**

After you enable Services for Network File System (NFS) on the media server and on the SQL back-end servers, you can disable Server for NFS.

**To disable the Server for NFS**

1. Open the Server Manager.
2. In the left pane, expand **Configuration**.
3. Click Services.

4. In the right pane, right-click on Server for NFS and click Stop.

5. In the right pane, right-click on Server for NFS and click Properties.
6 In the **Server for NFS Properties** dialog box, from the **Startup type** list, click **Disabled**.

7 Click **OK**.

8 Repeat this procedure for the media server and for each SQL back-end server.

---

**About configuring Services for Network File System (NFS) on the Windows 2003 R2 SP2 NetBackup media server and NetBackup clients**

---

**Note:** NetBackup does not support Granular Recovery Technology (GRT) with Windows Server 2003 R1 or earlier versions.

---

**Note:** For VMware backups and restores of SharePoint, the only systems that require configuration of NFS are the following: the systems that you use to browse for backups or the systems you use to perform restores. This configuration is not needed to capture the data during backups of the virtual machine.
### Table 3-3

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Install the necessary NFS components on the NetBackup media server.</td>
<td>See Table 3-4 on page 38. See “Installing Services for NFS on the Windows 2003 R2 SP2 media server” on page 38.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install the necessary NFS components on the SQL back-end servers.</td>
<td>See Table 3-4 on page 38. See “Installing Services for NFS on SQL back-end servers with Windows 2003 R2 SP2” on page 41. Note: If the SQL back-end server resides on the media server, install all the components on the media server.</td>
</tr>
<tr>
<td>Step 3</td>
<td>On all SQL back-end servers, install the hotfix for Client for NFS.</td>
<td>The hotfix is available at the following location: <a href="http://support.microsoft.comkb/947186">http://support.microsoft.comkb/947186</a></td>
</tr>
</tbody>
</table>

### Table 3-4

<table>
<thead>
<tr>
<th>NFS component</th>
<th>NetBackup client</th>
<th>NetBackup media server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client for NFS</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Microsoft Services for NFS Administration</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RPC External Data Representation</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RPC Port Mapper</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

## Installing Services for NFS on the Windows 2003 R2 SP2 media server

This topic describes how to install Services for NFS on a Windows 2003 R2 SP2 media server.

To install Services for NFS on the Windows 2003 R2 SP2 media server

1. Click **Start > Control Panel > Add or Remove Programs**.
2. Click **Add/Remove Windows Components**.
3. Check **Other Network File and Print Services** and click **Details**.

4. Check **Microsoft Service for NFS** and click **Details**.
5 Install the components that apply to your configuration.

- If the host is only a NetBackup media server, check the following components:
  - RPC External Data Representation
  - RPC Port Mapper

- If you have a single host that functions as both the media server and the SQL back-end server, check the following components:
  - Client for NFS
  - Microsoft Services for NFS Administration
  - RPC External Data Representation
  - RPC Port Mapper

6 Click OK.

7 Click OK.

8 Click Next and complete the Windows Components Wizard.

9 After the installation is complete, open Services in the Control Panel.

10 Depending on configuration of the host, verify that Client for NFS is running or is stopped and disabled:
For a single host that has both the media server and the SQL back-end server, ensure Client for NFS is running.

For a host that is only a NetBackup media server, Client for NFS can be stopped and disabled.

11. **Configure the portmap service to start automatically at server restart.**

Issue the following from the command prompt:

```
sc config portmap start= auto
```

This command should return the status `[SC] ChangeServiceConfig SUCCESS`.

### Installing Services for NFS on SQL back-end servers with Windows 2003 R2 SP2

This topic describes how to install NFS on the NetBackup clients with Windows 2003 R2 SP2. Only the clients that are SQL back-end servers require NFS. If a SQL back-end server is also a NetBackup media server, you must follow a different procedure.

See “Installing Services for NFS on the Windows 2003 R2 SP2 media server” on page 38.

**To install Services for NFS on the NetBackup clients with Windows 2003 R2 SP2**

1. Click **Start > Control Panel > Add or Remove Programs**.
2. Click **Add/Remove Windows Components**.
3 Check **Other Network File and Print Services** and click **Details**.

![Windows Components Wizard](image1)

4 Check **Microsoft Service for NFS** and click **Details**.

![Other Network File and Print Services](image2)
5 Check the following components:
- Client for NFS
- Microsoft Services for NFS Administration
- RPC External Data Representation

6 Click **OK**.

7 Click **OK**.

8 Click **Next** and complete the Windows Components Wizard.

9 After the installation is complete, open Services in the Control Panel.

10 Ensure the following that the Client for NFS service is running.

11 Repeat this procedure for each SQL back-end server.
Configuring a UNIX or Linux media server and Windows clients for backups and restores that use Granular Recovery Technology

To perform backups and restores that use Granular Recovery Technology, perform the following configuration if you use a UNIX or Linux media server and Windows clients:

- Confirm that your media server is installed on a platform that supports granular recovery. See the NetBackup X Operating System compatibility list.
- No other configuration is required for the UNIX or Linux media server.
- Enable or install NFS on the SQL back-end servers. See “Enabling Services for Network File System (NFS) on Windows 2008 or Windows 2008 R2” on page 30. See “Installing Services for NFS on SQL back-end servers with Windows 2003 R2 SP2” on page 41.
- You can configure a different network port for NBFSD. See “Configuring a different network port for NBFSD” on page 44.

Configuring a different network port for NBFSD

NBFS runs on port 7394. If another service uses the standard NBFS port in your organization, you can configure the service on another port. The following procedures describe how to configure a NetBackup server to use a network port other than the default.

To configure a different network port for NBFS (Windows server)

1. Log on as administrator on the computer where NetBackup server is installed.
2. Open Regedit.
3. Open the following key:
   HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

4. Create a new DWORD value named FSE_PORT.
5. Right-click on the new value and click Modify.
6. In the Value data box, provide a port number between 1 and 65535.
7. Click OK.
To configure a different network port for NBFD (UNIX or Linux server)

1. Log on as root on the computer where NetBackup server is installed.
2. Open the `bp.conf` file.
3. Add the following entry, where `XXXX` is an integer and is a port number between 1 and 65535.
   
   ```
   FSE_PORT = XXXX
   ```
Configuring a different network port for NBFSR
This chapter includes the following topics:

- About configuring NetBackup for SharePoint
- About user interface terminology
- Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)
- Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows
- Configuring the log on account for the NetBackup Legacy Network Service for NetBackup for SharePoint on Windows
- Configuring host properties for SharePoint clients
- Configuring restores for a SharePoint farm with multiple servers
- Testing configuration settings for NetBackup for SharePoint

About configuring NetBackup for SharePoint

To successfully perform backups and restores of SharePoint Server, complete the following steps.

For additional information on how to configure NetBackup in preparation of VMware backups that protect SharePoint, refer to the following topic.

See “About protecting SharePoint Server data with VMware backups” on page 115.
Table 4-1  Configuring NetBackup for SharePoint

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Review the information for configuring the backup and restore operations that use Granular Recovery Technology (GRT).</td>
<td>GRT lets you restore individual documents, etc., from a database backup. GRT is an option limited to certain versions of SharePoint Server and Windows Server. GRT is included in VMware backups that protect SharePoint. See “Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)” on page 49.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure the NetBackup Client Service.</td>
<td>Required if you want to restore individual mailboxes and public folder items with Granular Recovery Technology (GRT). See “Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows” on page 52.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure the NetBackup Legacy Network Service</td>
<td>See “Configuring the log on account for the NetBackup Legacy Network Service for NetBackup for SharePoint on Windows” on page 53.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure the host properties for SharePoint clients.</td>
<td>See “Configuring host properties for SharePoint clients” on page 53.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Configuring restores for multiple SharePoint Server hosts.</td>
<td>See “Configuring restores for a SharePoint farm with multiple servers ” on page 58.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Select the backup and recovery strategies that fit your environment.</td>
<td>See “About backup policies for granular backup and recovery of SharePoint Server” on page 61.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About backup policies for SharePoint farm backup and recovery” on page 62.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About backup policies for disaster recovery of SharePoint Server” on page 63.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About VMware backup policies that protect SharePoint Server” on page 64.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Test your configuration settings.</td>
<td>See “Testing configuration settings for NetBackup for SharePoint” on page 58.</td>
</tr>
</tbody>
</table>
About user interface terminology

You perform many configuration steps from the NetBackup Administration Console on the master server. The type of console available depends on your master server platform. NetBackup supports a Java interface for both Windows and UNIX master servers. In addition, NetBackup supports a Windows interface for Windows master servers.

The Java and Windows interfaces are nearly identical. If interface differences exist in the configuration procedures, the term “Windows” or “Java” appears in the procedure to differentiate between the two interfaces.

Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)

Before you configure for granular recovery with NetBackup, ensure that you have met the requirements for using Granular Recovery Technology (GRT). These requirements include the configuration of NFS.

See “Requirements for SharePoint Granular Recovery” on page 28.

**Table 4-2** Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Review the limitations and conditions.</td>
<td>See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51. See “Limitations and conditions for restores using SharePoint Granular Recovery Technology (GRT)” on page 51.</td>
</tr>
<tr>
<td>Step 2</td>
<td>On all SQL back-end servers, configure the NetBackup Client Service to log on with a domain-privileged account.</td>
<td>See “Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows” on page 51.</td>
</tr>
<tr>
<td>Step 3</td>
<td>For non-VMware backups, select <strong>Enable granular recovery</strong> in the backup policy.</td>
<td>Granular recovery is automatically provided for VMware backups that protect SharePoint. You do not need to enable it in the policy. See “Adding a new NetBackup for SharePoint policy” on page 65.</td>
</tr>
</tbody>
</table>
About a SharePoint non-granular backup vs. a backup that uses Granular Recovery Technology (GRT)

Non-granular backups allow the restore of SharePoint objects at the level of a Web Application. This type of backup also allows the restore at the level of the Single Sign-on database. Individual items cannot be restored from non-granular backups.

To restore individual items using Granular Recovery Technology (GRT), NetBackup performs a granular-level backup of the SharePoint Web Application. You can restore the entire database or you can restore items individually. Items can then be restored to the existing Web Application. Or you can redirect to a file system location. Individual items are cataloged for restore browsing and for recovery on a granular-level backup image.

**Note:** The farm databases (Configuration, Single Sign-on, Index Files, or Index database) cannot be backed up with a policy that is enabled for individual item restores. For comprehensive farm disaster recovery, back up those databases with a separate policy where individual document restores are disabled.

Table 4-3 describes what SharePoint objects can be restored with non-granular and granular-level backups.

**Table 4-3** SharePoint Server 2007 and later non-granular backup vs. a backup that uses Granular Recovery Technology

<table>
<thead>
<tr>
<th>Object</th>
<th>Can be restored from a non-granular backup</th>
<th>Can be restored from a backup that uses Granular Recovery Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration database</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Single Sign-on database</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Global Settings</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Index Files</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Shared Services (SharePoint 2007)</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Applications (SharePoint 2010)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Applications or Content databases</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 4-3  SharePoint Server 2007 and later non-granular backup vs. a backup that uses Granular Recovery Technology (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Can be restored from a non-granular backup</th>
<th>Can be restored from a backup that uses Granular Recovery Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site collections</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Subsites</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Individual lists or libraries</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Individual documents or list items</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* Only restore these items as part of a farm restore.

About disk storage units and restores that use Granular Recovery Technology (GRT)

Granular information is only cataloged for a backup image that is made to a disk storage unit. A backup that is made directly to tape does not contain granular information. You can duplicate the image to tape, but you cannot directly back up to tape. If you configure backups to a disk storage unit, no further configuration is required. You can only perform restores of individual items using Granular Recovery Technology (GRT) if the backup resides on a disk storage unit.

More information is available on the disk storage units that are supported with GRT.

See the *NetBackup Release Notes*.

Limitations and conditions for restores using SharePoint Granular Recovery Technology (GRT)

The following limitations and conditions exist for jobs using Granular Recovery Technology (GRT):

- The feature is limited to certain versions of SharePoint Server and Windows Server.
  
  See the *NetBackup Operating System Compatibility List*.
  See the *NetBackup Database Agent Compatibility List*.

- This feature only supports full and user-directed backups. NetBackup lets you create a complete policy for disaster recovery, with all the various types of
schedules. However, you cannot restore individual items from an incremental backup.

- Backups must be made to a disk storage unit, not to tape, and restores that use GRT must be made from a disk storage unit. You can manually duplicate the backup image to disk, but you cannot restore from the tape copy. See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51.

- Granular recovery of the SharePoint 2010 Central Administration Web site and the Shared Services Administration Web site is not supported.

- When you perform a granular recovery of documents, pictures, or list items the state of these items in the workflow is not preserved.

Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows

The NetBackup Client Service must be authorized to run as the system administrator (Windows 2008) or the SharePoint administrator (Windows 2003). In Windows Services, configure the NetBackup Client Service properties for the host(s) where the Index Files or Index database(s) reside and where the document libraries reside.

To configure the log on account for the NetBackup Client Service

1. Open the Windows Services application.
2. Double-click on the NetBackup Client Service entry.
3. Click on the Log On tab.
4. If Local System account is not selected as the Log on as account, proceed with step 9.
5. Provide the name of the account for the system administrator (Windows 2008) or the SharePoint administrator (Windows 2003).
6. Type the password.
7. Click OK.
8. Stop and start the NetBackup Client Service.
9. Close the Services control panel application.
Configuring the log on account for the NetBackup Legacy Network Service for NetBackup for SharePoint on Windows

The NetBackup Legacy Network Service must be authorized to run as the system administrator (Windows 2008) or the SharePoint administrator (Windows 2003). In Windows Services, configure the NetBackup Legacy Network properties for the host(s) where the Index Files or Index database(s) and where the document libraries reside.

To configure the log on account for the NetBackup Legacy Network Service

1. Open the Windows Services application.
2. Double-click on the NetBackup Legacy Network Service entry.
3. Click on the Log On tab.
4. If Local System account is not selected as the Log on as account, proceed with step 5.
5. Provide the name of the account for the system administrator (Windows 2008) or the SharePoint administrator (Windows 2003).
6. Type the password.
7. Click OK.
8. Stop and start the NetBackup Client Service.
9. Close the Services control panel application.

Configuring host properties for SharePoint clients

In the SharePoint client host properties you configure settings for the SharePoint clients you selected. Configure the host properties for all servers in the SharePoint farm.

To configure SharePoint client host properties

1. Open the NetBackup Administration Console or the Remote Administration Console.
2. In the left pane, expand NetBackup Management > Host Properties > Clients.
3. In the right pane, select the SharePoint client(s) you want to configure.
4. Click Actions > Properties.
5 Expand **Windows Client** and click **SharePoint**.

![SharePoint Configuration Dialog Box](image)

6 Enable the options you want.

   See “**SharePoint properties**” on page 54.

7 Click **OK**.

### SharePoint properties

The **SharePoint** properties apply to currently selected Windows clients to protect SharePoint Server installations.

The **SharePoint** dialog box contains the following properties.

**Table 4-4** SharePoint dialog box properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Domain\User</strong></td>
<td>Specifies the domain and the user name for the account you want to use to log on to SharePoint (DOMAIN\user name).</td>
</tr>
<tr>
<td></td>
<td>See “<strong>Specifying the account that logs on to the SharePoint application server</strong>” on page 55.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Specifies the password for the account.</td>
</tr>
</tbody>
</table>
Table 4-4  SharePoint dialog box properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consistency check before backup</td>
<td>Specifies the consistency checks to perform on the SQL Server databases before NetBackup begins a backup operation. These checks are performed for both server-directed and user-directed backups.</td>
</tr>
<tr>
<td></td>
<td>If you choose to perform a consistency check, you can select <strong>Continue with backup if consistency check fails</strong>. NetBackup then continues to perform the backup if the consistency check fails.</td>
</tr>
<tr>
<td></td>
<td>See “Performing consistency checks with NetBackup for SharePoint backups” on page 57.</td>
</tr>
<tr>
<td></td>
<td>See “Consistency check options for SharePoint Server” on page 57.</td>
</tr>
</tbody>
</table>

Specifying the account that logs on to the SharePoint application server

To perform backups and restores, NetBackup must know the user name and password of the account for the SharePoint administrator. NetBackup also requires this information so you can browse for SharePoint objects when you create a backup policy. NetBackup validates the user name and password you provide.

This account must meet the following requirements:

- It must have the following rights on the servers where the SharePoint components are installed: Local administrative privileges, domain administrative privileges, and site collection administration rights. The account must be a SharePoint farm administrator account.
- It must have certain local security privileges on the servers which have the content of the SharePoint farm. The front-end server must have registry access to the back-end database servers. See “Configuring local security privileges for the SharePoint Servers” on page 56.
- (SharePoint 2007) The credentials of the logon account that is used for backups and restores of the Single Sign-on database can be the account name. Or the credentials can be a member of the group for that account. (See the “Account name” box in the **Single Sign-on Settings**. These settings are located on the Manage Settings for the Single Sign-on administration page that is in SharePoint Server.)
- Internet Information Services (IIS) rights can affect database backups and restores. Ensure that the logon account that is used for backups and restores...
has rights to access the IIS sites. Integrated Windows Security should be enabled within the IIS rights.

To specify the logon account for the SharePoint application server

1. Open the NetBackup Administration Console.
2. Expand **NetBackup Management** > **Host Properties** > **Clients**.
3. In the right pane, right-click on the client and click **Properties**.
4. In the left pane, expand **Windows Client** and click **SharePoint**.
5. Click **OK** to save your changes.
6. Repeat this configuration for all servers in the SharePoint farm.
7. Configure the local security privileges for the SharePoint Servers.

   See “*Configuring local security privileges for the SharePoint Servers*” on page 56.

See “*Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows*” on page 52.

### Configuring local security privileges for the SharePoint Servers

On each SharePoint server in the farm you must assign certain local security privileges. These privileges are necessary since the NetBackup for SharePoint Agent logs on as the SharePoint user when it accesses data.

**To configure the local security privileges**

1. Open the Local Security Policy.
2. Click **Local Policies**.
3. In the User Rights Assignment, add the account to the following policies:
   - Allow log on locally
   - Log on as a service
   - Replace a process level token
4. Run the group policy update command (group policy update) for this change to take effect:

   ```
gpupdate /Force
```
Performing consistency checks with NetBackup for SharePoint backups

You can perform consistency checks of the SQL Server database(s) before NetBackup begins a SharePoint backup operation. These checks are performed for both server-directed and user-directed backups.

**To perform consistency checks with NetBackup for SharePoint backups**

1. Open the NetBackup Administration Console.
2. Expand NetBackup Management > Host Properties > Clients.
3. In the right pane, right-click on the client and select Properties.
4. In the left pane, expand Windows Client and click SharePoint.
5. From the Consistency check before backup list, choose which check NetBackup should perform before backups.

See “Consistency check options for SharePoint Server” on page 57 for descriptions of these options.

If you choose to perform a consistency check, you can select Continue with backup if consistency check fails. NetBackup then continues to perform the backup if the consistency check fails.

6. Click OK to save your changes.
7. Repeat this configuration for all servers in the SharePoint farm.

Consistency check options for SharePoint Server

The following consistency checks can be performed before a SharePoint Server backup.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Do not perform consistency checking.</td>
</tr>
<tr>
<td>Full check, excluding indexes</td>
<td>Select this option to exclude indexes from the consistency check. If indexes are not checked, the consistency check runs significantly faster but is not as thorough. Only the data pages and clustered index pages for each user table are included in the consistency check. The consistency of the non-clustered index pages is not checked.</td>
</tr>
<tr>
<td>Full check, including indexes</td>
<td>Include indexes in the consistency check. Any errors are logged.</td>
</tr>
<tr>
<td>Physical check only (SQL 2000 only)</td>
<td>Only applicable for SQL 2000.</td>
</tr>
</tbody>
</table>
Configuring restores for a SharePoint farm with multiple servers

NetBackup catalogs backup images under the SharePoint front-end server name. To allow NetBackup to restore content to each server in the farm, you must provide a list of the SharePoint servers. Set the following configuration parameters in the host properties for the master server.

To configure restores for a SharePoint farm with multiple servers
1. On the master server, open the NetBackup Administration Console.
3. In the right pane, double-click on the master server.
4. Select Distributed Application Restore Mapping.
5. Click Add.
6. For one of the servers in the farm, provide the name of the front-end server and the name of the component server in the farm.
7. Repeat step 5 and step 6 for each server in the farm.
8. If the back-end server is a clustered SQL host, add the virtual name. Also add the physical node names on which the server can run on in the cluster.

Testing configuration settings for NetBackup for SharePoint

After you configure the master server for NetBackup for SharePoint, test the configuration settings. Perform a manual backup (or backups) with the automatic backup schedules you created. A description of status codes and other troubleshooting information is available.

See the NetBackup Status Codes Reference Guide.
See the NetBackup Troubleshooting Guide.

To test the configuration settings
1. Log onto the master server as administrator (Windows) or root (UNIX).
2. Start the NetBackup Administration Console.
3 In the left pane, click Policies.

4 Click the policy you want to test.

5 Select Actions > Manual Backup.

   The Schedules pane contains the name of an automatic schedule (or schedules) configured for the policy that you want to test. The Clients pane contains the name of the client(s) listed in the policy that you want to test.

6 Follow the directions in the Manual Backup dialog box.

7 To check the status of the backup, click Activity Monitor in the NetBackup Administration Console.

   A parent job contains the whole file list and one or more child jobs. A child job is automatically launched for each host that contains SharePoint data. For example, assume that a SharePoint farm consists of four separate hosts. In this case, one parent job and four child jobs appear in the Activity Monitor. The front-end Web server is listed as the client name for all jobs.

   For more information, see the Troubleshooting chapter.
Testing configuration settings for NetBackup for SharePoint
Configuring NetBackup for SharePoint backup policies

This chapter includes the following topics:

- About backup policies for granular backup and recovery of SharePoint Server
- About backup policies for SharePoint farm backup and recovery
- About backup policies for disaster recovery of SharePoint Server
- About VMware backup policies that protect SharePoint Server
- About configuring a backup policy for a SharePoint database

About backup policies for granular backup and recovery of SharePoint Server

A SharePoint granular backup provides you with the ability to restore individual items from the backup using Granular Recovery Technology (GRT). This type of backup does not provide protection for the full farm or disaster recovery.

**Note:** The Microsoft SharePoint Resources: \AllWebs directive includes the SharePoint 2010 administration sites in a backup. However, granular recovery of the SharePoint 2010 Central Administration Web site and the Shared Services Administration Web site is not supported.

Create an **MS-SharePoint** policy for each individual Web Application or create a policy with the **Microsoft SharePoint Resources: \AllWebs** directive. Enable the **Enable granular recovery** option in the policy. (See Table 5-1, see Policy A or B.)
See “Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)” on page 49.

Table 5-1  
NetBackup for SharePoint policy examples for granular recovery

<table>
<thead>
<tr>
<th>Policy and policy type</th>
<th>Backup selections</th>
<th>Auto backup frequency</th>
<th>Enable granular recovery</th>
<th>Other configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy A, MS-SharePoint</td>
<td>Microsoft SharePoint Resources\AllWebs</td>
<td>Weekly Full</td>
<td>Yes</td>
<td>The backup image must reside on a disk storage unit.</td>
</tr>
<tr>
<td>Policy B, MS-SharePoint</td>
<td>Microsoft SharePoint Resources\Web Application name</td>
<td>Weekly Full</td>
<td>Yes</td>
<td>The backup image must reside on a disk storage unit.</td>
</tr>
</tbody>
</table>

About backup policies for SharePoint farm backup and recovery

A farm-level backup provides a complete backup of the SharePoint installation. It does not, however, provide for disaster recovery, as some components must be backed up with an MS-Windows policy. Granular recovery is not available from this type of backup. If you enable granular recovery with this policy, NetBackup backs up only SQL objects in the farm.

Create an MS-SharePoint policy. Exclude the Index Files from incremental backups in this policy (in Table 5-2, see Policy A). Or exclude the Index Files from both the full and the incremental backups and back up that database in a separate policy. (In Table 5-2, Policies B-1 and B-2).

See “About configuring a backup policy for a SharePoint database” on page 65.
Table 5-2  NetBackup for SharePoint policy examples for full farm backups

<table>
<thead>
<tr>
<th>Policy and policy type</th>
<th>Backup selections</th>
<th>Auto backup frequency</th>
<th>Enable granular recovery</th>
<th>Other configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy A MS-SharePoint</td>
<td>Microsoft SharePoint Resources:*</td>
<td>Weekly Full Daily Incremental</td>
<td>No</td>
<td>Include the Index Files in the full farm backup and exclude the Index Files from the farm incremental backups. Add directives for individual Index Files to the exclude list: Microsoft SharePoint Resources:\Web Application name\Index-DB* To back up the Index with a separate policy, see Policy A-2.</td>
</tr>
<tr>
<td>Policy B-1 MS-SharePoint</td>
<td>Microsoft SharePoint Resources:*</td>
<td>Weekly Full Daily Incremental</td>
<td>No</td>
<td>Exclude the Index Files from the full and the incremental farm backups. Add directives for individual Index Files to the exclude list: Microsoft SharePoint Resources:\Web Application name\Index-DB*</td>
</tr>
<tr>
<td>Policy B-2 MS-SharePoint</td>
<td>Microsoft SharePoint Resources:\Web Application name\Index-DB*</td>
<td>Weekly Full</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

About backup policies for disaster recovery of SharePoint Server

To provide for full disaster recovery of SharePoint Server, you must create a farm-level backup and a Windows backup of certain file system components.

In addition to the **MS-SharePoint** policy(s), create an **MS-Windows** policy. This policy should include the file system where SharePoint Web parts can be installed and System State directive (Shadow Copy Components). Exclude any databases from this policy; they are included in the SharePoint policy backup. A backup of the System State protects the IIS metadata.

See “About configuring a backup policy for a SharePoint database” on page 65.
### Table 5-3: NetBackup for SharePoint policy examples for disaster recovery

<table>
<thead>
<tr>
<th>Policy and policy type</th>
<th>Backup selections</th>
<th>Auto backup frequency</th>
<th>Enable granular recovery</th>
<th>Other configuration</th>
</tr>
</thead>
</table>
| Policy A MS-SharePoint | Microsoft SharePoint Resources:\* | Weekly Full Daily Incremental | No | Include the Index Files in the full farm backup and exclude the Index Files from the farm incremental backups. Add directives for individual Index Files to the exclude list: Microsoft SharePoint Resources:\Web Application name\Index-DB*  
To back up the Index with a separate policy, see Policy A-2. |
| Policy B-1 MS-SharePoint | Microsoft SharePoint Resources:\* | Weekly Full Daily Incremental | No | Exclude the Index Files from the full and the incremental farm backups. Add directives for individual Index Files to the exclude list: Microsoft SharePoint Resources:\Web Application name\Index-DB* |
| Policy B-2 MS-SharePoint | Microsoft SharePoint Resources:\Web Application name\Index-DB* | Weekly Full | No |
| Policy C MS-Windows | Shadow Copy Components:\ALL_LOCAL_DRIVES | Weekly Full Daily Incremental | No | Exclude any databases from this policy. Add the paths for any databases to the exclude list. |

## About VMware backup policies that protect SharePoint Server

VMware backups that protect SharePoint Server provide granular recovery, complete protection of the farm, and protection of the SharePoint components in the Windows files system. These system components include SharePoint Web parts and the System State directive (Shadow Copy Components). VMware incremental backups that protect SharePoint Server are not supported with this version of NetBackup.

More information is available on how to configure VMware backups that protect SharePoint.
About configuring a backup policy for a SharePoint database

A backup policy for a database defines the backup criteria for a specific group of one or more clients. These criteria include the following:

- Storage unit and media to use
- Policy attributes
- Backup schedules
- Clients to be backed up

See the *NetBackup Administrator’s Guide, Volume I.*

To add and configure a policy, see the following topics:

- See “About policy attributes for NetBackup for SharePoint” on page 66.
- See “Adding schedules to a NetBackup for SharePoint policy” on page 67.
- See “Adding clients to a NetBackup for SharePoint policy” on page 72.

Adding a new NetBackup for SharePoint policy

This topic describes how to add a new backup policy for a database.

**To add a new NetBackup for SharePoint policy**

1. Log on to the master server as administrator (Windows) or root (UNIX).
2. Start the NetBackup Administration Console.
3. If your site has more than one master server, choose the one on which you want to add the policy.
4. Do one of the following:
   - Windows: In the left pane, right-click **Policies** and choose **New Policy**.
   - Java interface: In the left pane, click **Policies**. In the **All Policies** pane, right-click the master server, and click **New Policy**.
5. In the **Add a New Policy** dialog box, in the **Policy name** box, type a unique name for the new policy.
6 Click OK.

7 In the Add New Policy dialog box, in the Policy type list, select MS-SharePoint.

The database agent policy type does not appear in the drop-down list unless your master server has a license key for the database agent.

8 (Optional) To enable restores of individual items from database backups, click Enable granular recovery.

See “Configuring NetBackup for SharePoint backups that use Granular Recovery Technology (GRT)” on page 49.

9 Complete the entries on the Attributes tab.

See “About policy attributes for NetBackup for SharePoint” on page 66.

10 Add other policy information as follows:

- Add schedules.
  See “Adding schedules to a NetBackup for SharePoint policy” on page 67.

- Add clients.
  See “Adding clients to a NetBackup for SharePoint policy” on page 72.

- Add database objects to the backup selections list.
  See “Creating a backup selections list for a SharePoint Server policy” on page 72.

11 For backups that use Granular Recovery Technology (GRT), configure the list of SharePoint hosts.

See “Configuring restores for a SharePoint farm with multiple servers” on page 58.

12 When you have added all the schedules, clients, and backup selections you need, click OK.

About policy attributes for NetBackup for SharePoint

With a few exceptions, NetBackup manages a database backup like a file system backup. Other policy attributes vary according to your specific backup strategy and system configuration.

For more information on policy attributes, see the NetBackup Administrator’s Guide, Volume I.
Table 5-4  Policy attribute descriptions for NetBackup for SharePoint policies

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy type</td>
<td>Determines the types of clients that can be in the policy. In some cases the policy type determines the types of backups that NetBackup can perform on those clients. To use the SharePoint database agent, you must define at least one policy of type that is MS-SharePoint.</td>
</tr>
<tr>
<td>Limit jobs per policy</td>
<td>Limits the number of jobs that NetBackup performs concurrently with this policy. Set this option to 1 for the policies that are used to back up SharePoint databases.</td>
</tr>
<tr>
<td>Take checkpoints every</td>
<td>Checkpoint restart is not supported with NetBackup for SharePoint policies.</td>
</tr>
<tr>
<td>Allow multiple data streams</td>
<td>For SharePoint policies, do not select this option. SharePoint policies do not support multiple data streams.</td>
</tr>
<tr>
<td>Enable granular recovery</td>
<td>Allows restores of individual items using Granular Recovery Technology (GRT). Documents external to the document library such as lists, calendars, and discussion boards cannot be restored individually. Users can only restore individual items from a full backup. You can restore individual items only if the backup image resides on a disk storage unit. If you want to retain a granular backup on tape, you must duplicate the image. If you want to restore from a granular backup that was duplicated to tape, you must import the image to a disk storage unit. See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51. SharePoint Server GRT-enabled backups do not support encryption or compression.</td>
</tr>
<tr>
<td>Keyword phrase</td>
<td>A textual description of a backup. Useful for browsing backups and restores.</td>
</tr>
</tbody>
</table>

Adding schedules to a NetBackup for SharePoint policy

Each policy has its own set of schedules. These schedules control the initiation of automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for SharePoint policy

1. In the Policy dialog box, click the Schedules tab.
   To access the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.
2. Click New.
3. Specify a unique name for the schedule.
4. Select the Type of backup.
   See “SharePoint Server backup types” on page 69.
5. Choose a frequency level appropriate for the type of backup.

6. Specify the other properties for the schedule.

   See “About NetBackup for SharePoint schedule properties” on page 68.

7. Click OK.

**About NetBackup for SharePoint schedule properties**

This topic describes the schedule properties that have a different meaning for database backups than for file system backups. Other schedule properties vary according to your specific backup strategy and system configuration. Additional information about other schedule properties is available.

See the *NetBackup Administrator’s Guide, Volume I*.

**Table 5-5** Description of schedule properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of backup</td>
<td>Specifies the type of backup that this schedule controls. The selection list shows only the backup types that apply to the policy you want to configure.</td>
</tr>
<tr>
<td></td>
<td>See “SharePoint Server backup types” on page 69.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>You can schedule a backup in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>■ Frequency</td>
</tr>
<tr>
<td></td>
<td>This setting is used only for scheduled backups. It is not used for user-directed backups.</td>
</tr>
<tr>
<td></td>
<td><strong>Frequency</strong></td>
</tr>
<tr>
<td></td>
<td>This setting specifies the period of time that can elapse until the next backup or archive operation begins on this schedule. For example, assume that the frequency is seven days and a successful backup occurs on Wednesday. The next full backup does not occur until the following Wednesday. Typically, incremental backups have a shorter frequency than full backups.</td>
</tr>
<tr>
<td></td>
<td>■ Calendar</td>
</tr>
<tr>
<td></td>
<td>This setting is used only for scheduled backups. It is not used for user-directed backups.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Calendar</strong> option allows you to schedule backup operations that are based on specific dates, recurring week days, or recurring days of the month.</td>
</tr>
<tr>
<td>Retention</td>
<td>Specifies a retention period to keep backup copies of files before they are deleted. The retention level also denotes a schedule priority within the policy. A higher level has a higher priority. Set the time period to retain at least two full backups of your database. In this way, if one full backup is lost, you have another full backup to restore. For example, if your database is backed up once every Sunday morning, you should select a retention period of at least 2 weeks.</td>
</tr>
</tbody>
</table>
### SharePoint Server backup types

Table 5-6 describes the type of backups that are available with the SharePoint Agent.

<table>
<thead>
<tr>
<th>Type of Backup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full Backup</strong></td>
<td>Select this backup type to back up the entire SharePoint component database(s). Granular-level backups must be backed up with a full backup. A list is available for the objects that support full backups. For SharePoint 2010, see Table 5-8. For SharePoint 2007, see Table 5-8.</td>
</tr>
<tr>
<td><strong>User Backup</strong></td>
<td>A user backup is not automatically scheduled and is initiated from the front-end Web server. This schedule allows for granular recovery. You may want a separate policy for User Backup schedule types. With a separate policy, you can easily separate user-directed and scheduled backups when you restore files. If you create a separate policy for User Backup schedule types, the considerations are similar to those for automatic backups. A backup selections list is not needed because users select the files before the backup begins.</td>
</tr>
<tr>
<td><strong>Cumulative</strong></td>
<td>This type of backup is not supported for SharePoint Server.</td>
</tr>
</tbody>
</table>
Table 5-6 Description of types of backups (continued)

<table>
<thead>
<tr>
<th>Type of Backup</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Differential Incremental backup** | Select this backup type to only back up the changes that are made to the database since the last full backup or previous incremental backup. You cannot restore individual items from an incremental restore.  
A list is available for the objects that support incremental backups.  
For SharePoint 2010, see Table 5-8.  
For SharePoint 2007, see Table 5-8.  
**Note:** The SharePoint 2007 Shared Search Index database and Index Files only support full backups. Therefore, Symantec recommends that these databases are excluded from the differential incremental schedule. If these databases are included in this type of schedule, a full backup is performed as part of the incremental backup.  
**Note:** Incremental backups are not supported for granular-level backups. |

Table 5-7 describes the schedule types that are supported for SharePoint Server 2010 and SharePoint Foundation objects.

Table 5-7 Schedule types supported for SharePoint Server 2010 and SharePoint Foundation objects

<table>
<thead>
<tr>
<th>SharePoint 2010/SharePoint Foundation objects</th>
<th>Schedule type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Global Settings</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Single Sign-On</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Web Application/Content DB/ (including individual document restores)</td>
<td>Full backup</td>
</tr>
<tr>
<td>WSS Help Search/Index Files</td>
<td>Full backup</td>
</tr>
<tr>
<td>WSS Help Search/Search DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>WSS Administration/Web App/Content DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Shared Services/Services DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
</tbody>
</table>
Table 5-7  Schedule types supported for SharePoint Server 2010 and SharePoint Foundation objects (continued)

<table>
<thead>
<tr>
<th>SharePoint 2010/SharePoint Foundation objects</th>
<th>Schedule type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared Services/Shared Search Index/Index Files</td>
<td>Full backup</td>
</tr>
<tr>
<td>Shared Services/Shared Search Index/ Search DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Shared Services/Web App/Content DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
</tbody>
</table>

Table 5-8 describes the schedule types that are supported for SharePoint Server 2007 and WSS objects.

Table 5-8  Schedule types supported for SharePoint Server 2007 and WSS objects

<table>
<thead>
<tr>
<th>SharePoint 2007/WSS objects</th>
<th>Schedule type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Global Settings</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Single Sign-On</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Web Application/Content DB/ (including individual document restores)</td>
<td>Full backup</td>
</tr>
<tr>
<td>WSS Help Search/Index Files</td>
<td>Full backup</td>
</tr>
<tr>
<td>WSS Help Search/Search DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>WSS Administration/Web App/Content DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Shared Services/Services DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Shared Services/Shared Search Index/Index Files</td>
<td>Full backup</td>
</tr>
<tr>
<td>Shared Services/Shared Search Index/Search DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
<tr>
<td>Shared Services/Web App/Content DB</td>
<td>Full backup, Differential Incremental backup</td>
</tr>
</tbody>
</table>
Adding clients to a NetBackup for SharePoint policy

The clients list contains a list of the clients that are backed up during an automatic backup. A NetBackup client must be in at least one policy but can be in more than one.

The NetBackup client software must be installed on each of the following: the front-end Web server, the SQL database host, and the Index Files or the Index database host. The client software does not need to be installed on the Search or the Job servers.

To add clients to a NetBackup for SharePoint policy

1. In the Policy dialog box, click the Clients tab.

   To access the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.

2. Click New.

3. Type the name of the client and press Enter (Windows) or click Add (Java).

   Only add the client that is the front-end Web server and knows about the SharePoint farm topology to the policy list.

4. (Windows) To add another client, repeat step 2 and step 3.

5. (Java) To add another client, repeat step 3.

6. If this client is the last client you want to add, click OK.

7. (Java) In the Policy dialog box, click Close.

Creating a backup selections list for a SharePoint Server policy

The backup selections list defines the SharePoint objects to be backed up. You can specify the entire farm or back up individual SharePoint components, such as a Single Sign-on, Configuration, or Content database.

Symantec recommends that you create backup selections with the browse feature. Because SharePoint objects have long names, it is easy to mistype the object name when you create backup selections by adding and editing directives. One exception is the Microsoft SharePoint Resources:\AllWebs directive. Use this directive to back up all Web applications. You do not need to add a separate backup selection for each Web application.

To browse for the SharePoint objects, you must provide the credentials for the account that logs on to the SharePoint Server.

See “Specifying the account that logs on to the SharePoint application server” on page 55.
Note: SharePoint policies do not support multiple data streams.

More information is available on how to configure SharePoint policies. This topic includes the following procedures:

- See “To create a backup selections list to back up SharePoint Server objects” on page 73.
- See “To create a backup selections item for all Web applications” on page 73.

To create a backup selections list to back up SharePoint Server objects

1. In the Policy dialog box, click the Backup Selections tab.
2. Click New.
3. Click the folder icon to browse for a SharePoint object.
4. In the left pane, expand the client and select the object you want to back up.
   - If you selected Enable granular recovery on the Attributes tab, the display is limited to Web applications.
5. Click OK.
6. Repeat step 2 through step 5 for each object you want to add.

To create a backup selections item for all Web applications

1. In the Policy dialog box, click the Backup Selections tab.
2. Click New.
3. Click in the edit box and type Microsoft SharePoint Resources:\AllWebs.
   - This directive works for both Web applications.

See “SharePoint Server backup types” on page 69.

See “Testing configuration settings for NetBackup for SharePoint” on page 58.

See “Performing consistency checks with NetBackup for SharePoint backups” on page 57.
Configuring NetBackup for SharePoint backup policies

About configuring a backup policy for a SharePoint database
Performing backups and restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

This chapter includes the following topics:

■ About NetBackup for SharePoint Server backup and restores
■ About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services
■ About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

About NetBackup for SharePoint Server backup and restores

With NetBackup for SharePoint, you can perform user-directed backups and restores of SharePoint Server components. You can also restore individual items from the backups that use Granular Recovery Technology (GRT).

See “About installing and configuring Network File System (NFS) for SharePoint Granular Recovery” on page 27.
See “Configuring a UNIX or Linux media server and Windows clients for backups and restores that use Granular Recovery Technology” on page 44.

See “About requirements for restores of individual SharePoint items using Granular Recovery Technology (GRT)” on page 94.

See “About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 76.

See “About backup options for NetBackup for SharePoint” on page 77.

See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.

See “Restore options for SharePoint Server” on page 80.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab” on page 81.

See “How the NetBackup Recovery Assistant restores SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 84.

See “Restoring SharePoint Server, SharePoint Foundation, or Windows SharePoint Services” on page 85.

See “Restoring individual SharePoint items from full database backups” on page 95.

### About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

User-directed backups of SharePoint Server must be performed from the front-end Web server. Back up the Content, Services, and User profile databases together.

If the policy that has a user backup schedule enables consistency checks, these checks are also performed before user-directed backups.

**Note:** If you open multiple backup windows (in the NetBackup client) to browse SharePoint resources, the windows may unexpectedly terminate. Instead, use a single backup window to browse SharePoint resources for backup.

See “Performing consistency checks with NetBackup for SharePoint backups” on page 57.

See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.
Specifying the server and client for a SharePoint Server backup operation

When you perform user backups of SharePoint Server, you can specify the server that you want to perform the backups.

To specify the server and client for a backup operation

1. Log onto the server as Administrator.
2. Open the Backup, Archive, and Restore interface.
3. Select File > Specify NetBackup Machines and Policy Type.
4. In the Specify NetBackup Machines and Policy Type dialog box, provide the following information:
   - **Server to use for backups and restores**: Select the server you want to perform the backup.
   - **Source client for restores (or virtual client for backups)**: Not applicable for SharePoint backups.
5. Click OK.

About backup options for NetBackup for SharePoint

Table 6-1 lists the options that are available when you perform backups of SharePoint Server.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup to NetBackup server</strong></td>
<td>Identify the NetBackup server that you want to perform the backup.</td>
</tr>
<tr>
<td><strong>Items marked to be backed up</strong></td>
<td>Contains a list of objects to be backed up.</td>
</tr>
</tbody>
</table>
Performing backups and restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

Performing a user-directed backup of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services

This topic describes how to perform a user-directed backup of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services.

To back up SharePoint resources

1. Log onto the server as Administrator.
2. Open the Backup, Archive, and Restore interface.
4. In the Backup window, in the All Folders pane, expand Microsoft SharePoint Resources.

See “About NetBackup for SharePoint Server backup and restores” on page 75.

See “Performing a user-directed backup of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services” on page 78.

See “Restoring individual SharePoint items from full database backups” on page 95.

### Table 6-1  Backup options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyword phrase to associate with the backup or archive</strong></td>
<td>Specify a keyword phrase, up to 128 characters in length, that NetBackup can associate with the image created by this backup operation. You then can restore the image by specifying the keyword phrase in the Search Backups dialog box. All printable characters are permitted including space (&quot; &quot;) and period (&quot;.&quot;). The default keyword phrase is the null (empty) string.</td>
</tr>
</tbody>
</table>
5 Select the object(s) to back up.

6 Choose Actions > Backup.

   See “About backup options for NetBackup for SharePoint” on page 77.

7 In the Backup Files dialog box, click Start Backup.

   If you want to view the progress of the backup, click Yes. If you do not want to view the progress of the backup, click No.

   See “About NetBackup for SharePoint Server backup and restores” on page 75.

   See “About user-directed backups of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 76.

   See “Restoring individual SharePoint items from full database backups” on page 95.

About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

Note the following when you perform restores:

■ Administer restores from the NetBackup master server or the SharePoint front-end server.

■ When you select an item for restore, do not select (or mark) items in the All Folders pane. In the All Folders pane, click on, but do not select the checkbox for the parent folder. Then, in the Contents of pane, select the specific object you want to restore.
The Configuration database contains all of the configuration information for the entire SharePoint server farm. Use caution when you restore this database; upon restore, any changes are lost that you made to the farm topology after the backup was performed.

When you select for restore some but not all Content databases for a Web application, the Web application is not unprovisioned. After you restore the selected Content databases, those databases are re-attached.

Even if SharePoint components exist on multiple computers, all the backups are cataloged under the same SharePoint server name. Once you select that server name, all available backup images for your SharePoint environment are displayed.

Specifying the server, client, and the policy type for a SharePoint Server restore operation

When you perform restores, you select the following information:

- The master server that performed the backup
- The SharePoint front-end client that was backed up
- The SharePoint policy type

To specify the server, client, and policy type for a SharePoint Server restore operation

1. Log onto the server as Administrator.
2. Open the Backup, Archive, and Restore interface.
3. Click **File > Specify NetBackup Machines and Policy Type**.
4. In the **Specify NetBackup Machines and Policy Type** dialog box, from the **Server to use for backups and restores** list, select the NetBackup server that performed the restore.
5. From the **Source client for restores** list, select the client.
   - The source client is the SharePoint Server front-end client whose backup images you want to browse.
6. From the **Policy type for restores** list, choose **MS-SharePoint**.
7. Click **OK**.

Restore options for SharePoint Server

The following options are available when you restore SharePoint Server, SharePoint Foundation, or Windows SharePoint Services:
See “Restore options for SharePoint Server on the General tab” on page 81.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab” on page 81.

**Restore options for SharePoint Server on the General tab**

The options on this tab are not supported for NetBackup for SharePoint.

If you want to redirect a Web application, you need to follow a different procedure.

See “Redirecting a restore of a SharePoint Web application within a farm” on page 106.

See “Redirecting a restore of a SharePoint Web application to another farm” on page 109.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab” on page 81.

**Restore options for SharePoint Server on the Microsoft SharePoint tab**

On this tab you can choose to bring databases online after a restore job. You can also specify a different location to which to redirect a Web application. The farm and the Web application to which you want to redirect the restore must already exist.

**Table 6-2 Microsoft SharePoint tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring restored databases online and reconnect previous database links</td>
<td>Select this option to bring the databases online after a restore job. This option also re-establishes the link between the restored databases and their corresponding Web applications.</td>
</tr>
<tr>
<td>Release the lock on the SharePoint farm topology, if it is set.</td>
<td>This option applies to SharePoint 2003 only.</td>
</tr>
<tr>
<td>Preserve existing Internet Information Services (IIS) Web site and application pool.</td>
<td>If the Web site and application pool for the SharePoint Web application that you restore already exists in IIS, this option preserves them during restore. If you do not check this option, the Web site and application pool are deleted from IIS during the restore. After they are deleted, they are recreated in the default location that SharePoint specifies.</td>
</tr>
</tbody>
</table>
### Table 6-2 Microsoft SharePoint tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If versioning is enabled on the restore destination</strong></td>
<td>If versioning is enabled on the destination to which you want to restore an individual item or document, select one of the following options:</td>
</tr>
<tr>
<td>■ <strong>Add as a new version</strong></td>
<td>NetBackup restores the existing item or document as a new version, which makes it the most recent version of the existing item. For example, assume that you have five versions of <code>testfile.doc</code> and choose to restore version 2.0 of the file. When the file is restored, it is added as <code>testfile.doc 6.0</code> and is the most recent version.</td>
</tr>
<tr>
<td>■ <strong>Skip if the item exists</strong></td>
<td>NetBackup does not restore the item if an identical item or document exists in the restore destination. NetBackup notes that the file was skipped in the job log.</td>
</tr>
</tbody>
</table>
| ■ **Restore over existing items**           | NetBackup restores the existing item as a new version and deletes the existing version. For example, assume that the version history is as follows: `testfile.doc version 3.0
` `testfile.doc version 2.0
` `testfile.doc version 1.0
` `testfile.doc` version 3 is the most recent version. If you choose to restore `testfile.doc version 2.0`, the restore adds `testfile.doc version 4.0` and deletes `testfile.doc version 2.0`. So the version history appears as follows: `testfile.doc version 4.0
` `testfile.doc version 3.0
` `testfile.doc version 1.0
` `testfile.doc version 2.0` is now version 4.0 of the file.                                                                                                      |
| **If versioning is not enabled on the restore destination** | If versioning is not enabled on the destination to which you want to restore an individual item, select one of the following options:                                                                                                                                                                                                                     |
| ■ **Skip if the item exists**               | NetBackup does not restore the item if an identical item exists in the restore destination. NetBackup indicates that the file was skipped in the log.                                                                                                                                                                                                 |
| ■ **Restore over existing items**           | NetBackup replaces the existing item with the restored item.                                                                                                                                                                                                                                                                                  |
| **Restore only the most recent version of an item** | Check this option to only restore the most recent version of an item. Note that NetBackup restores the most recent version of the versions you selected for restore. If a more recent version exists, but you did not select it for restore that version is not restored.                                                                                                 |
Table 6-2  Microsoft SharePoint tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Include security information   | Check this option to restore any applicable security information with the item. Note that security information is restored only if you select a parent folder and not when you select individual items. For example, security information is restored when you select Shared Documents, but not if you select an individual document. However, an individual object can have user permissions that are defined with a level of “limited access.” In this case, permissions for those users are not restored with that object. You can restore different levels of security based on the SharePoint item you restore:  
  ■ Sites  
    User and SharePoint Group information and security ACL are restored for top-level sites.  
  ■ Subsites  
    Security ACL is restored.  
  ■ Lists  
    Security ACL and other security-related information are restored.                                                                                     |
| Redirect SharePoint Resources   | Check this option to redirect a Web application.                                                                                                                                                             |
|                                | See “Redirecting a restore of a SharePoint Web application within a farm” on page 106.                                                                                                                      |
|                                | See “Redirecting a restore of a SharePoint Web application to another farm” on page 109.                                                                                                                   |
| SharePoint 2003 portal sites or SharePoint 2007 web applications | To redirect a Web application, specify the URL of the destination site and the name of the target front-end Web server.                                                                                       |
|                                | Example URLs include the following:                                                                                                                                                                         |
|                                | http://URL to Web application                                                                                                                                                                               |
|                                | Indicate the host name of the Web server to which you want to redirect. The Web server must already exist on the destination location.                                                                     |
| Individual SharePoint sites, documents, lists, or items | You can redirect documents or pictures to a path, as follows:                                                                                                                                            |
|                                | ■ Redirect to path  
    In the **Restore to drive or UNC path** box, enter the drive letter or UNC Path. Use the following format for a UNC path: `\servername\share`.  
    In the **Restore to path** box, enter the path to which you want to direct the restore. Note that when you direct items to a file system, any list items you selected are not restored and appear as 0-KB files.  
    Note that when you direct items to a file system, any list items you selected are not restored and appear as 0-KB files.  
    ■ Redirect to workspace or document library (WebStorageSystem-based only).  
    This option only applies to SharePoint 2001 restores.                                                                                             |
|                                | See “Restore options for SharePoint Server on the General tab” on page 81.                                                                                                                               |
How the NetBackup Recovery Assistant restores SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

The NetBackup Recovery Assistant launches a restore job for each database in a Web application. Databases are restored in the proper order to ensure that a working Web application exists when the restore is complete. After all the databases are restored any items you selected are restored in a single job.

For SharePoint 2010, the Recovery Assistant restores objects in the following order:

- Configuration databases (only if assistant is run in disaster recovery mode)
- Content databases
- Services databases
- Index Files
- Document sets, documents, lists, etc.

For SharePoint 2007, the Recovery Assistant restores objects in the following order:

- Configuration databases (only if assistant is run in disaster recovery mode)
- Content databases
- Services databases
- Index Files
- Single Sign-on databases
- Documents, lists, etc.

Objects are skipped if they are not found in the database configuration. Each restore may only restore a portion of the components depending on what objects you select and the backup image you select. When you restore an item, it does not restore an entire Content database or Document library.

See “Restoring the SharePoint 2007 Shared Services Provider” on page 91.

See “Recovering a SharePoint Web application in a farm with multiple front-end servers (SharePoint 2007 or later)” on page 100.

See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.
Restoring SharePoint Server, SharePoint Foundation, or Windows SharePoint Services

Multiple SharePoint Server resources can be restored together. The NetBackup Recovery Assistant determines the order in which the resources must be restored. You can restore any of the SharePoint resources in separate restore operations.

Note: NetBackup does not prevent you from restoring placeholders. NetBackup also lets you restore any object that can hold a document, even if it does not contain a document.

Restoring SharePoint Server, SharePoint Foundation, or Windows SharePoint Services

1. Enable the front-end Web server to redirect restores to the SQL hosts in the farm.

   A redirected restore is performed since backups are cataloged under the front-end client name for the Federated SharePoint farm.

   See “Configuring restores for a SharePoint farm with multiple servers” on page 58.

2. Log on as Administrator.

3. Open the Backup, Archive, and Restore interface.

4. Choose File > Select Files and Folders to Restore > from Normal Backup.

5. Select the MS-SharePoint policy type.

   See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.

6. Click OK.

   NetBackup browses for SharePoint Server backup images.

7. From the NetBackup History pane, select the image(s) that contain the objects you want to restore:

   - The last full backup, or
   - The last full backup and all subsequent differential backups

8. In the All Folders pane, expand Microsoft SharePoint Resources.

   Note: When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.
9 In the **Contents of** pane, check the checkbox for the SharePoint resources to restore.

To select a database, click on (but do not check the checkbox for) the parent folder in the **All Folders** pane. Then check the checkbox for the database in the **Contents of** pane.

The following image shows a restore of a SharePoint 2010 Content database.

![Image of SharePoint 2010 restore](image1)

The following image shows a restore of a SharePoint 2007 Content database.

![Image of SharePoint 2007 restore](image2)
If you want to restore a subsite, expand the site collection in the All Folders pane. Then check the checkbox for the subsite in Contents of pane.

**Note:** For a successful restore, you must select the Index Files folder(s) exactly as described here.

If you want to restore the SharePoint 2010 Index Files, do the following:

- In the All Folders pane, click on the folder for the Shared Services Application but do not select the checkbox for it.
- In the Contents of pane, select each Index Files folder.
10 Choose **Actions > Restore.**
11 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

![Restore Marked Files dialog box](image)

See “Restore options for SharePoint Server 2003 on the Microsoft SharePoint tab” on page 137.

12 Click Start Restore.

Restoring the SharePoint 2010 Search Service Application

The following instructions describe how to restore the Shared Services Application. Select all of the components of the Search Service application for recovery. The SharePoint Agent un-provisions the Search service application, restores the components, and recovers the Search service application.
To restore the SharePoint 2010 Search Service Application

1. Open the NetBackup Backup, Archive, and Restore interface.

2. Open a Restore window.

3. Select the full backup that contains the shared services.

4. In the All Folders pane, expand Microsoft SharePoint Resources > Shared Services > Shared Services Applications.

5. Select each Index Files folder for restore as follows:

   Note: For a successful restore, you must select the Index Files folder(s) exactly as described here.

   - In the All Folders pane, click on the folder for the Shared Services Application but do not select the checkbox for it.
   - In the Contents of pane, select each Index Files folder.

6. Select each Shared Services database for restore as follows:

   Note: For a successful restore, you must select the database(s) exactly as described here.

   - In the All Folders pane, click on the folder for the Shared Services database but do not select the checkbox for it.
   - In the Contents of pane, select the Shared Services database.
7 Choose Actions > Restore.
8 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.
9 Uncheck Bring restored databases online and reconnect previous database links.
10 Click Start Restore.
11 Restore any incremental backups. Do not select Bring restored databases online and reconnect previous database links except for the last incremental backup.

See “Recovering a SharePoint Web application in a farm with multiple front-end servers (SharePoint 2007 or later)” on page 100.

See “Restoring a deleted SharePoint list” on page 102.

See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.

Restoring the SharePoint 2007 Shared Services Provider

The following instructions describe how to restore the Shared Services Provider.
To restore the SharePoint 2007 Shared Services Provider

1. If the Shared Services Provider is not in a state of unprovisioning, continue with step 2, otherwise delete the Shared Services Provider as follows.

Run the following command:

```
stsadm -o deletessp -title SSP name -force
```

After the SSP is deleted from SharePoint, on the SQL Server ensure that the Services database and the Search database are no longer present.

2. Open the NetBackup Backup, Archive, and Restore interface.

3. Open a Restore window.

4. Select the full backup that contains the shared services.

5. In the All Folders pane, expand Microsoft SharePoint Resources > Shared Services.

6. Select the Shared Services database for restore as follows:

   **Note:** For a successful restore, you must select the database exactly as described here.

   - In the All Folders pane, click on the folder for the Shared Services database but do not select the checkbox for it.

   - In the Contents of pane, select the Shared Services database.

7. Select the Search database for restore as follows:

   **Note:** For a successful restore, you must select the database exactly as described here.

   - In the All Folders pane, click on the folder for the Search database but do not select the checkbox for it.
In the **Contents of** pane, select the Search database.

8 Select the Content database for restore as follows:

**Note:** For a successful restore, you must select the database exactly as described here.

- In the **All Folders** pane, click on the folder for the Content database but do not select the checkbox for it.
- In the **Contents** of pane, select the Content database.

9 Select the Index Files for restore as follows:

**Note:** For a successful restore, you must select the Index Files exactly as described here.

- In the **All Folders** pane, click on **Shared Search Index** but do not select the checkbox for it.
- In the **Contents** of pane, select the Index Files folder.
10 Choose **Actions > Restore**.

11 In the **Restore Marked Files** dialog box, click the **Microsoft SharePoint** tab.

12 Uncheck **Bring restored databases online and reconnect previous database links**.

13 Click **Start Restore**.

14 Restore any incremental backups. Do not select **Bring restored databases online and reconnect previous database links** except for the *last* incremental backup.

See “Recovering a SharePoint Web application in a farm with multiple front-end servers (SharePoint 2007 or later)” on page 100.

See “Restoring a deleted SharePoint list” on page 102.

See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.

### About requirements for restores of individual SharePoint items using Granular Recovery Technology (GRT)

The following requirements must be met to restore individual items from full database backups Granular Recovery Technology (GRT):

- The administrator has configured NetBackup to allow for restores of individual items. This option is on the **Attributes** tab for the backup policy.
  
  See “About policy attributes for NetBackup for SharePoint” on page 66.

- The user must restore from a full backup image.
You can only restore an individual item when the backup image resides on a disk storage unit. See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51.

See “About installing and configuring Network File System (NFS) for SharePoint Granular Recovery” on page 27.

See “Configuring a UNIX or Linux media server and Windows clients for backups and restores that use Granular Recovery Technology” on page 44.

Restoring individual SharePoint items from full database backups

You can restore individual sites, subsites, documents, images, and list items from the full SharePoint database backup jobs that use Granular Recovery Technology (GRT).

**Note:** Granular recovery of the SharePoint 2010 Central Administration Web site and the Shared Services Administration Web site is not supported.

**Note:** When you restore an item, it is safe to ignore certain bprd errors in the Activity Monitor similar to the following:

7/12/2007 11:01:39 AM - Error bpdm (pid=2928) did not receive EXIT STATUS from bprd, all blocks may not have been restored

Instead, rely on the final status that is reported in the Activity Monitor to determine the true success or failure of the restore operation.

To restore individual SharePoint items from full database backups

1. Enable the Sharepoint front-end Web server to restore to the SQL hosts in the farm.
   See “Configuring restores for a SharePoint farm with multiple servers” on page 58.

2. Log on as Administrator.

3. Open the Backup, Archive, and Restore interface.

4. Choose **File > Select Files and Folders to Restore > from Normal Backup**.

5. Select the **MS-SharePoint** policy type.
   See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.
6 Click OK.

NetBackup browses for SharePoint Server backup images.

7 From the NetBackup History pane, select the full backup image that contains the items you want to restore.

8 In the All Folders pane, expand Microsoft SharePoint Resources.

---

**Note:** When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.
9. In the **Contents of** pane, select the item(s) to restore.

Note that security information is restored only if you select a parent folder and not when you select individual items. For example, security information is restored when you select Shared Documents, but not if you select an individual document. However, an individual object can have the user permissions that are defined with a level of “limited access.” In this case, permissions for those users are not restored with that object.

The following image shows a SharePoint 2010 restore.

The following image shows a SharePoint 2007 restore.
10 Choose Actions > Restore.

11 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

12 Choose your restore options, as follows:
If versioning is enabled on the restore destination

Select one of the following options:

- **Add as a new version**
  NetBackup restores the existing item as a new version, making it the most recent version of the existing item.

- **Skip if the item exists**
  NetBackup does not restore the item if an identical item exists in the restore destination. NetBackup notes that the file was skipped in the job log.

- **Restore over existing items**
  NetBackup restores the existing item as a new version and deletes the existing version.

For examples see the following topic:

See “Restore options for SharePoint Server 2003 on the Microsoft SharePoint tab” on page 137.

If versioning is not enabled on the restore destination

Select one of the following options:

- **Skip if the item exists**
  NetBackup does not restore the item if an identical item exists in the restore destination. NetBackup notes that the file was skipped in the job log.

- **Restore over existing items**
  NetBackup replaces the existing item with the restored item.

Restore only the most recent version of an item

Check this option if you only want to restore the most recent versions of any individual items you have selected for restore.

Include security information

Check this option if you want to restore the SharePoint security information that is attached to the items you restore.

See “Restore options for SharePoint Server” on page 80.

13 Select the other restore options you want.

See “Restore options for SharePoint Server” on page 80.

14 Click **Start Restore**.

See “Restoring a deleted SharePoint list” on page 102.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab” on page 81.

See “Performing a user-directed backup of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services” on page 78.
Recovering a SharePoint Web application in a farm with multiple front-end servers (SharePoint 2007 or later)

To restore a deleted web application in a Network Load Balanced (NLB) farm, you may need to perform a manual operation using the SharePoint Central Administration interface. After the restore operation is successful, if the Web application on the NLB farm is offline, perform the following steps.

**Note:** After you complete the following steps, a change is reflected in the IIS attributes for the primary configured balanced node. The new balanced load server contains two sites: the original site and the name of the latest site that you create in step 13. However, both sites link to the original site and there is no affect on the environment.

**To recover a SharePoint Web application in a farm with multiple front-end servers**

1. Log on as Administrator.
2. Open the Backup, Archive, and Restore interface.
3. Choose **File > Select Files and Folders to Restore > from Normal Backup**.
4. Select the **MS-SharePoint** policy type.
   
   See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.
5. Click **OK**.
   
   NetBackup browses for SharePoint Server backup images.
6. From the **NetBackup History** pane, select the image(s) that contain the objects you want to restore:
   
   - The last full backup, or
   - The last full backup and all subsequent differential backups
7. In the **All Folders** pane, expand **Microsoft SharePoint Resources** and the Web application.

**Note:** When you select items to restore, do not check the checkbox for an item in the **All folders** pane. Only check the checkbox for an item in the **Contents of** pane.
8 In the Contents of pane, select the Content database.

The following image shows a SharePoint 2010 restore.

![SharePoint 2010 Restore Image]

The following image shows a SharePoint 2007 restore.

![SharePoint 2007 Restore Image]

9 Restore the database to the primary front end.

Note that you only need to perform this action once.

10 Open the SharePoint Central Administration interface.

11 Under Central Administration, click Application Management.

12 Under SharePoint Web Application Management, click Create or extend Web application.

13 Select Extend an existing Web application.
14 Do the following to extend the Web application:

■ Click on the link for the Web application and select Change Web Application. Fill in the values to extend the restored Web application.

■ Select Create a new IIS Web site and fill in the information to match the original Web application. However, you cannot use the same port number.

■ In the Load Balanced URL section, provide the node name of the load balanced server. (For example, http://VMSP-3:new port.)

15 After you complete step 14, all other configured front-ends may be automatically updated with IIS entries. If so, no further action is required.

If other front-ends require load balancing, then repeat step 12 through step 14.

See “Redirecting a restore of a SharePoint Web application to another farm” on page 109.

See “Restoring individual SharePoint items from full database backups” on page 95.

See “Restore options for SharePoint Server” on page 80.

Restoring a deleted SharePoint list

To restore a list that you deleted, you need to restore the list and default.aspx in separate restore jobs.

To restore a deleted list

1 Log on as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Choose File > Select Files and Folders to Restore > from Normal Backup.

4 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.

5 Click OK.

NetBackup browses for SharePoint Server backup images.

6 From the NetBackup History pane, select the image(s) that contain the objects you want to restore:

■ The last full backup, or

■ The last full backup and all subsequent differential backups
7 In the All Folders pane, expand Microsoft SharePoint Resources.

**Note:** When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.

8 From the Contents of pane, select the list item you deleted or the library container for the list.

The following image shows a SharePoint 2010 restore.

![SharePoint 2010 Restore Image]

The following image shows a SharePoint 2007 restore.

![SharePoint 2007 Restore Image]
9  Click **Start Restore**.
    When the restore completes, continue with the next step.

10  In the **All Folders** pane, expand **Microsoft SharePoint Resources**.
Performing backups and restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services

11 From the Contents of pane, in the subsite or the site collection, select default.aspx.

The following image shows a SharePoint 2010 restore.

![SharePoint 2010 Restore Image]

The following image shows a SharePoint 2007 restore.

![SharePoint 2007 Restore Image]

12 Click Start Restore.
Redirecting a restore of a SharePoint Web application within a farm

In a SharePoint Server 2007 or later farm a Web application restore can be redirected within the same farm or to a different farm. For instructions on how to redirect to a different farm, see the following topic:

See “Redirecting a restore of a SharePoint Web application to another farm” on page 109.

Note the following when you redirect a Web application within a farm:

■ The source Web application cannot be a live Web application.
■ The Web application target to which you want to redirect the restore must already exist on the specified Web server.
■ The target must have the same database structure as the source Web application.
■ You can only redirect a Web application from a full backup. Redirection is not supported from differential backups.
■ You can restore configuration databases and single sign-on databases back to the original location only. Document sets and individual SharePoint items must be restored to their original site or redirected to a file system.
■ You can redirect a restore of a Web application within the same farm. The SQL database host and the SharePoint host must be the same. A redirected restore is not supported if the SQL databases exist across multiple SQL hosts.
■ You must restore all SQL databases in one operation at the same time.

To redirect a restore of a SharePoint Web application within a farm

1 Log on as Administrator.
2 Create the target Web application on the target Web server. The target site must have the same database structure as the source site.
3 Remove the source Web application.
   If you attempt the redirected restore without removing the source, the restore completes successfully, but the databases are not properly connected to the virtual server.
4 Open the Backup, Archive, and Restore interface.
5 Click File > Select Files and Folders to Restore > from Normal Backup.

6 Select the MS-SharePoint policy type.

   See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.

7 From the NetBackup History pane, select the full backup image that contains the objects you want to restore.

8 In the All Folders pane, expand Microsoft SharePoint Resources.

   **Note:** When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.
9 In the Contents of pane, select the Web application to redirect.

The following image shows a SharePoint 2010 restore.

![SharePoint 2010 restore image]

The following image shows a SharePoint 2007 restore.

![SharePoint 2007 restore image]

10 Click Actions > Restore.

11 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

12 Check Redirect SharePoint Resources.

13 Click SharePoint 2003 portal sites or SharePoint 2007 web applications.

14 In the URL box, type the URL of the destination site:
http://webapp
15 In the Front end web server name box, indicate the host name of the Web server.

See “Restore options for SharePoint Server” on page 80.

16 Click Start Restore.

Redirecting a restore of a SharePoint Web application to another farm

In a SharePoint Server 2007 or later farm a Web application restore can be redirected within the same farm or to a different farm. For instructions on how to redirect within a farm, see the following topic:

See “Redirecting a restore of a SharePoint Web application within a farm” on page 106.

Note the following when you redirect a Web application to another farm:

- The Web application target to which you want to redirect the restore must already exist on the specified Web server. It also must have the same number of content databases as the source Web application.
- The target Web application and SQL database name must have new names (different from original names).
- The SharePoint version from the source farm must match the SharePoint version of the destination farm.
- You can only redirect a Web application from a full backup. Redirection is not supported from differential backups.
- The Web applications must be restored at the database level.
- The destination SharePoint farm nodes must be in the NetBackup domain.
- In the host properties for the master server, configure the Distributed Application Restore Mapping settings.
  These settings must contain the mapping for the destination farm. A distributed application must have all the farm nodes of the destination SharePoint farm mapped as components of the source SharePoint front end.
- The Windows Client Properties for the destination farm nodes must be set for SharePoint for all nodes in the farm.
- A NetBackup client must be installed on all nodes of the destination farm.
- You cannot complete a redirected restore if the SQL databases exist across multiple SQL hosts.
- You must restore all redirected Web application SQL databases in one operation at the same time.
- You cannot redirect a Web application to the same farm more than once. This restriction ensures SQL database ID uniqueness.
- The SharePoint version of the source and destination must be the same.
- The SQL version of the source and destination must be the same.
- You must manually restore from the MS-Windows backup image any custom Web parts that were created on the file system. These components are not backed up with the MS-SharePoint policy. (For example, you must manually restore C:\inetpub\wwwroot\wss\VirtualDirectories\port number.)

To redirect a restore of a SharePoint Web application to another farm

1. Log on as Administrator.
2. Create the target Web application on the target Web server.
3. Open the Backup, Archive, and Restore interface.
4. Click File > Select Files and Folders to Restore > from Normal Backup.
5. Select the MS-SharePoint policy type.
   See “Specifying the server, client, and the policy type for a SharePoint Server restore operation” on page 80.
6. From the NetBackup History pane, select the full backup image that contains the objects you want to restore.
7. In the All Folders pane, expand Microsoft SharePoint Resources.

Note: When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.
8 In the **Contents** of pane, select the Web application to redirect.

   The following image shows a SharePoint 2010 restore.

![SharePoint 2010 Restore Image]

   The following image shows a SharePoint 2007 restore.

![SharePoint 2007 Restore Image]

9 Click **Actions > Restore**.

10 In the **Restore Marked Files** dialog box, click the **Microsoft SharePoint** tab.

11 Check **Redirect SharePoint Resources**.

12 Click **SharePoint 2003 portal sites or SharePoint 2007 web applications**.

13 In the **URL** box, type the URL of the destination site:

   `http://webapp:port`

   Use the URL that appears in SharePoint Central Administration.
14 In the **Front end web server name** box, indicate the host name of the target Web server.

See “**Restore options for SharePoint Server**” on page 80.

15 Click **Start Restore**.

Redirecting individual SharePoint items to a file path

You can redirect individual SharePoint items to a file path. These items include the restore of SharePoint document sets, documents, and pictures. It also possible to restore individual items such as documents and pictures that were originally embedded in the lists objects. Individual items can only be redirected to a file location, not another content database.

Note that when you direct items to a file system, any list items you selected are not restored and appear as 0-KB files.

**To redirect individual SharePoint items to a file path**

1 Log on as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Choose **File > Select Files and Folders to Restore > from Normal Backup**.

4 Select the **MS-SharePoint** policy type.

   See “**Specifying the server, client, and the policy type for a SharePoint Server restore operation**” on page 80.

5 From the **NetBackup History** pane, select the full backup image that contains the objects you want to restore. You cannot restore individual items from a backup that did not use Granular Recovery Technology.

6 In the **All Folders** pane, expand **Microsoft SharePoint Resources**.

   **Note:** When you select items to restore, do not check the checkbox for an item in the **All folders** pane. Only check the checkbox for an item in the **Contents of** pane.
7 In the Contents of pane, select the documents or pictures you want to redirect.

8 Select Actions > Restore.

9 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

10 Select Redirect SharePoint Resources.

11 Select Individual SharePoint sites, documents, lists, or items.

12 Select Redirect to path.
13 In the **Restore to drive or UNC path** and **Restore to path** boxes, enter the drive letter and path to which you want to direct the restore. Use the following format for a UNC path:

```
\\servername\share
```

More information is available on other available restore options. See “**Restore options for SharePoint Server**” on page 80.

14 Click **Start Restore**.
Protecting SharePoint Server data with VMware backups

This chapter includes the following topics:

- About protecting SharePoint Server data with VMware backups
- Limitations of using a VMware policy to protect SharePoint Server
- Support for VMware backups that protect SharePoint Server
- About configuring NetBackup for VMware backups that protect SharePoint Server
- Restoring SharePoint data from a VMware backup

About protecting SharePoint Server data with VMware backups

Through a VMware backup policy, NetBackup can create consistent full backups of an SharePoint Server that resides on a virtual machine. To protect a supported application with a VMware policy, there is a new job or phase during the backup. An Application State Capture (ASC) job executes after the VMware discovery job and before the snapshot job(s). This ASC job contacts the NetBackup client on the guest virtual machine. The ASC job collects and catalogs application, the specific data that is needed for application recovery and granular recovery (GRT) functionality.

More information is available on the ASC job and its associated logs.
Limitations of using a VMware policy to protect SharePoint Server

The following limitations exist when you configure a VMware policy to protect SharePoint Server:

- VMware incremental backups of SharePoint Server are not supported with this version of NetBackup.
- SQL Servers cannot be clustered.
- The Application State Capture (ASC) job fails and the databases are not protected if you do any of the following:
  - Disable the Virtual Machine quiesce option.
  - Select the Exclude data disks option.

Databases are cataloged and protected only if they exist in a configuration that is supported for VMware backups. As long as there are any databases that can be protected, the ASC job continues. If you select databases for backup that exist on supported and on unsupported disks, the ASC job produces a status 1 (partially successful). The ASC job detects these situations and the job details include the result of the backup operation.

SharePoint Server databases are not cataloged and backed up if they exist on the following:

- Raw device mapping (RDMs). Make sure that the SharePoint virtual machine does not use RDM as storage for databases.
- Virtual Machine Disk (vmdk) volumes that are marked as independent. Make sure that the SharePoint databases are not stored on independent disks.
- Mount point volumes.
- Virtual hard disks (VHDs).
  - If NetBackup detects any database objects on a VHD, the ASC job fails and no SharePoint content is cataloged. This exclusion includes any objects that do not exist on the VHD.
- Any components that reside on a physical machine are not backed up with the VMware backup.
The ASC job detects an excluded Windows boot disk and treats it like an independent disk. The VMware backup cannot exclude for any reason the disk on which NetBackup is installed. For example, do not select the *Exclude boot disk* option if NetBackup is installed on the boot drive (typically C:).

See “Troubleshooting VMware backups and restores of SharePoint Server” on page 133.

### Support for VMware backups that protect SharePoint Server

VMware backups that protect SharePoint Server are supported on SharePoint Server 2007 and later x64 with ESX 4.0 and later.

### About configuring NetBackup for VMware backups that protect SharePoint Server

To successfully perform VMware backups and restores of SharePoint Server, complete the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Configure the NetBackup Client Service.</td>
<td>See “Configuring the log on account for the NetBackup Client Service for NetBackup for SharePoint on Windows” on page 52.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure the NetBackup Legacy Network Service.</td>
<td>See “Configuring the log on account for the NetBackup Legacy Network Service for NetBackup for SharePoint on Windows” on page 53.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure the local security privileges.</td>
<td>See “Configuring local security privileges for the SharePoint Servers” on page 56.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configuring restores for multiple SharePoint Server hosts.</td>
<td>See “Configuring restores for a SharePoint farm with multiple servers” on page 58.</td>
</tr>
</tbody>
</table>
Table 7-1 Configuring NetBackup for VMware backups that protect SharePoint Server (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 5 | Review the requirements and limitations for granular restores. | See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51.  
See “Limitations and conditions for restores using SharePoint Granular Recovery Technology (GRT)” on page 51. |
| Step 6 | For Federated SharePoint configurations, configure the granular proxy on the master server. | See “Configuring the granular proxy for Federated SharePoint configurations” on page 120.                                                    |
| Step 7 | Configure the host properties for each SharePoint client. | See “Configuring host properties for SharePoint clients” on page 53.                                                                      |
| Step 8 | Create a VMware backup policy.                  | See “Configuring a VMware backup policy for SharePoint Server ” on page 119.                                                              |
| Step 9 | Test your configuration settings.                | See “Testing configuration settings for NetBackup for SharePoint” on page 58.                                                              |

Configuring for Granular Recovery Technology (GRT) with a VMware backup that protects SharePoint Server

For a VMware backup that protects SharePoint Server, granular recovery is automatically enabled. Complete the following steps to ensure that granular recovery is successful.

Table 7-2 Configuring for Granular Recovery Technology (GRT) with a VMware backup that protects SharePoint

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Review the limitations and conditions. | See “About disk storage units and restores that use Granular Recovery Technology (GRT)” on page 51.  
See “Limitations and conditions for restores using SharePoint Granular Recovery Technology (GRT)” on page 51. |
| Step 2 | Configure the list of SharePoint hosts. | See “Configuring restores for a SharePoint farm with multiple servers ” on page 58.                                                      |
Configuring a VMware backup policy for SharePoint Server

Through a VMware backup policy, NetBackup can create full application consistent backups of a SharePoint Server that resides on a virtual machine. For complete details on how to create a policy for SharePoint Server backups in a VMware environment, see the instructions in the following document:

*NetBackup for VMware Administrator’s Guide*

These instructions describe how to configure a VMware policy with the **Enable SharePoint Recovery** setting. Alternatively, you can also use **Enable SQL Recovery**. Do not select both recovery options. If both options are selected, the SQL snapshot preparation fails.

Note the following:

- Incremental backups are not supported for SharePoint Server with a VMware backup policy.
- Consistency checks of the SharePoint Server are not performed with VMware backups.
- Granular Recovery Technology (GRT) is automatically enabled in the VMware policy and cannot be disabled.

To configure a VMware policy for SharePoint Server

1. Create a new policy or open the policy you want to configure.
2. In the **Policy** dialog box, click the **Attributes** tab.
3. In the **Policy type** list, click **VMware**.
4. On the **Clients** tab, you must add clients using a query, not manually.
5. Click the **VMware** tab.
   For details on the options in this dialog box, see the following document:
   
   *NetBackup for VMware Administrator’s Guide*

6. Check **Enable file recovery from VM backup**.
   This option must be enabled for application protection of SharePoint Server.
7 Uncheck **Enable block-level incremental backup.**
This option must be disabled for VMware backups that protect SharePoint Server.

8 Check **Enable SharePoint Recovery.**
This option enables recovery of the SharePoint databases or individual objects from the virtual machine backups. If this option is disabled, you can recover the entire virtual machine from the backup, but you cannot recover the SharePoint databases or objects individually.

**Configuring the granular proxy for Federated SharePoint configurations**

For Federated SharePoint configurations, you need to configure the granular proxy on the master server. Use the `bpclient` command to configure the back-end SQL server name for the catalog hosts (front-end servers in the farm) as the granular proxy.

```
bpclient -add -client SharePoint front-end server -granular_proxy SQL back-end server
```

To perform a query:

```
bpclient query -client SharePoint front-end server -G
```

**Restoring SharePoint data from a VMware backup**

SharePoint data is restored from a VMware backup in the same manner that it is restored from a backup that is performed with the SharePoint Agent. Though you use a VMware policy type to back up the data, you still use the MS-SharePoint policy type for the restore. NetBackup displays the SharePoint data in the VMware backup image that is available for restore.

**Note:** NetBackup only supports full VMware backups that protect SharePoint. In a VMware environment, you cannot restore NetBackup for SharePoint (MS-SharePoint) differential restores.

Note the following when you restore SharePoint data from a VMware backup:

- For the policy type, select **MS-SharePoint**.
- For the source client, select the name of the SharePoint front-end server. Select the server that is listed first alphabetically in the list of front-end servers.
- Even if SharePoint components exist on multiple computers, all the backups are cataloged under the same SharePoint server name. Once you select that
server name, all available backup images for your SharePoint environment are displayed.

- Follow the instructions for a SharePoint restore from a non-VMware environment.
  
  See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.

To restore SharePoint data from a VMware backup

1. For the policy type, select **MS-SharePoint**.

2. For the source client, select the name of the SharePoint front-end server.
   
   Select the server that is listed first alphabetically in the list of front-end servers.

3. Follow the instructions for a SharePoint restore from a non-VMware environment.

   See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.
Protecting SharePoint Server data with VMware backups

Restoring SharePoint data from a VMware backup
Disaster recovery

This chapter includes the following topics:

- About disaster recovery of a SharePoint Server
- Requirements for disaster recovery of a SharePoint Server
- Recovering a SharePoint 2010 Server (without BMR)
- Recovering a SharePoint 2007 Server (without BMR)

About disaster recovery of a SharePoint Server

SharePoint Server uses Windows 2003 or Windows 2008 security for authentication. Because of this configuration, disaster recovery of a SharePoint Server cannot be separated from the disaster recovery of Windows. You must recover the Windows server before you recover the SharePoint Server.

If you purchased the NetBackup Bare Metal Restore option. Refer to NetBackup Bare Metal Recovery Administrator’s Guide for more information. If you do not have BMR, see the “Disaster Recovery” chapter in the NetBackup Troubleshooting Guide.

Requirements for disaster recovery of a SharePoint Server

The following requirements exist for disaster recovery of a SharePoint Server:

- A copy of NetBackup for Windows with the license for NetBackup for SharePoint Server added on the master server
- The latest backup of the SharePoint Server you want to recover
- The SharePoint Server CD
Recovering a SharePoint 2010 Server (without BMR)

This topic describes how to recover a SharePoint 2010 Server installation without Bare Metal Restore (BMR).

To recover a SharePoint 2010 Server (without BMR)

1. Prepare the SharePoint host for restore. Configure it the same as the original host.
   - This configuration may involve new hardware and reinstalling the OS, Windows services packs, and the software that is needed to restore SharePoint from backup.

2. Install any prerequisite software and SharePoint 2010.
   - This installation includes running the SharePoint Products Configuration Wizard.

3. Create a new farm configuration database using the SharePoint Products Configuration Wizard.

4. Open your Web browser and verify that you can access the SharePoint Central Administration pages and that the configuration includes the original farm members.
   - Run the Farm Configuration Wizard, if applicable.

5. Configure the NetBackup master server and the SharePoint client hosts so you can restore SharePoint from the backup.

6. From the front-end server open the NetBackup Backup, Archive, and Restore interface.

7. Verify that the Microsoft SharePoint Resources: \ are visible.

8. Restore the components of the SharePoint Server in the following order:
   - Web application(s), one at a time
   - Services (State Service database, metadata, and State Service Proxy)
   - Shared Services databases (Service application and metadata), one at a time
■ SharePoint Foundation Help Search (WSS_Search)
■ InfoPath Forms Services (Metadata)
■ Index files

Shared Services Proxies should not be restored. (When NetBackup restores the Service application it generates new URIs and proxies for the Service application.)

9 Ensure that all the SharePoint and the SQL services are restarted on the SharePoint and the SQL Server, including the IIS service.

10 Use the SharePoint Central Administration, IIS, or the NetBackup Backup, Archive, and Restore interface to browse the Web application sites. Verify that the Web application sites you restored are accessible and were restored properly.

Recovering a SharePoint 2007 Server (without BMR)

This topic describes how to recover a SharePoint 2007 Server installation without Bare Metal Restore (BMR).

To recover a SharePoint 2007 Server (without BMR)

1 Configure the destination host the same as the original host.

2 Install SharePoint 2007 and any other required software.

3 Run the SharePoint Products and Technologies Configuration Wizard to create and attach new SharePoint farm configuration database.

4 Use the SharePoint Central Administrator to start the required search services on the newly created SharePoint farm.

5 Configure the NetBackup master server that has the backup images from the original host as the master server for the destination host.

6 Restore all the components of the SharePoint farm, except the Configuration database. Restore the components in the following order:

■ Search database
■ Web Application(s)
■ Shared Service Provider, if any
■ Single Sign-on database, if any
■ Search Index Files
Disaster recovery

Recovering a SharePoint 2007 Server (without BMR)
Troubleshooting

This chapter includes the following topics:

- About NetBackup for SharePoint debug logging
- About NetBackup status reports
- Troubleshooting SharePoint jobs that use Granular Recovery Technology (GRT)
- About troubleshooting SharePoint restore operations
- About NetBackup for SharePoint and client-side deduplication
- Troubleshooting VMware backups and restores of SharePoint Server

About NetBackup for SharePoint debug logging

The NetBackup master server and client software offers a comprehensive set of debug logs for troubleshooting problems that can occur during NetBackup operations. Debug logging is also available for SharePoint Server backup and restore operations.

See the following topics for information on how to create the logs and how to control the amount of information written to the logs.

See “Enabling the debug logs for a NetBackup for SharePoint client automatically” on page 128.

See “Enabling the debug logging for NetBackup for SharePoint manually” on page 128.

See “Setting the debug level on a NetBackup for SharePoint Windows client” on page 129.
After you determine the cause of the problem, disable debug logging by removing the previously created debug logging directories. Details are available on the contents of these debug logs.

See the NetBackup Troubleshooting Guide.

Additional information about NetBackup client logs and NetBackup master server logs is available.

See the online help for the Backup, Archive, and Restore interface.

See the NetBackup Administrator’s Guide, Volume I.

**Note:** When debug logging is enabled, the files can become large. The same files are used by normal file backups.

### Enabling the debug logs for a NetBackup for SharePoint client automatically

You can enable debug logging by running a batch file that creates each log directory. To create all log file directories automatically, run the following:

```
install_path\NetBackup\logs\mklogdir.bat
```

### Enabling the debug logging for NetBackup for SharePoint manually

To turn on debug logging, create the log directories in the following location:

```
install_path\NetBackup\logs
```

Create the following log directories on the SQL Server, the front-end Web server, the media server, and the master server:

- **beds**: SharePoint managed code in the SharePoint front-end server
- **bpbkar**: all backups
- **bpfis**: Snapshot backups, VMware backups
- **bppfi**: (Pre-NetBackup 6.5.4 backup images) SharePoint individual item restore using Granular Recovery Technology (GRT) and SharePoint database restores from VMware images
- **bpresolver**: all backups and restores
- **bpbrm**: all restores
- **bprd**: all restores
nblbc  SharePoint live browse if the backup image type is VMware
ncflbc  SharePoint individual item restore using GRT
        This log is for nblbc.exe.
ncfgre  SharePoint individual item restore using GRT
        This log is for nbgre.exe.
ncfnbcs  For ASC issues and failures with VMware backups
nbfsd  SharePoint individual item restore using GRT
spps  SharePoint managed code in the SharePoint front-end server
spsv2ra  Recovery Assistant
        This process uses unified logging.
tar  all restores

After you create these directories and perform a backup or restore, debug logging information is placed in a subdirectory that has the name of the process directory. For legacy logging, the file is named \mmdyy.log. For unified logging, the log file is in a format that is standardized across Symantec products. To view the logs that use unified logging, use lv.exe or vxlogview.

For more information about unified logging, see the NetBackup Administrator’s Guide. For information on how to use the log commands, see the NetBackup Troubleshooting Guide.

See “Viewing the progress report of a NetBackup for SharePoint operation” on page 130.

See “Troubleshooting SharePoint jobs that use Granular Recovery Technology (GRT)” on page 131.

See “About troubleshooting SharePoint restore operations” on page 131.

See “About NetBackup for SharePoint and client-side deduplication” on page 132.

Setting the debug level on a NetBackup for SharePoint Windows client

To control the amount of information that is written to the debug logs, change the General, Verbose, and Database debug levels on the client(s). Typically, the default value of 0 is sufficient. However, technical support may ask you to set the value higher to analyze a problem.

The debug logs are located in install_path\NetBackup\logs.
To set the debug level on a NetBackup for SharePoint client

1. From the Windows Start menu, choose Programs > Symantec NetBackup > Backup, Archive, and Restore.
2. Select File > NetBackup Client Properties.
3. Click the Troubleshooting tab.
4. Set the General debug level.
   Set this level as high as 2.
5. Set the Verbose debug level.
   Set this level as high as 5.
6. Click OK to save your changes.

About NetBackup status reports

NetBackup provides many standard status reports to verify the completion of backup and restore operations. In addition, users and the administrator can set up additional reports if a site requires them.

The administrator has access to operational progress reports through the NetBackup Administration Console. Reports can be generated for Status of Backups, Client Backups, Problems, All Log Entries, Media Lists, Media Contents, Images on Media, Media Logs, Media Summary, and Media Written. These reports can be generated for a specific time frame, client, or master server.

See the NetBackup Administrator’s Guide, Volume I for details.

Progress reports on the client allow easy monitoring of user operations. When reports are created by the NetBackup client for each user-directed backup or restore operation, administrators can monitor these operations and detect any problems that may occur.

See “Viewing the progress report of a NetBackup for SharePoint operation” on page 130.

Viewing the progress report of a NetBackup for SharePoint operation

This topic describes how to view the progress report of a NetBackup for SharePoint backup or restore operation.
To view the progress report of a NetBackup for SharePoint operation

1. Choose **File > View Status**.
2. Click the task for which you want to check the progress.
3. Click **Refresh**.

More information is available on progress reports and the meaning of the messages.

See the *NetBackup Backup, Archive, and Restore Getting Started Guide*.

Troubleshooting SharePoint jobs that use Granular Recovery Technology (GRT)

Note the following when you use NetBackup to perform backup or restore operations using Granular Recovery Technology:

- Disable or uninstall Qlogic San Surfer software. It may conflict with the port mapper for Client for NFS.
- Before you install NFS on the media server or client(s), look for the ONC Portmapper service. If it exists, stop it and disable it. Otherwise, the installation of NFS Services for Windows fails.
- In the Local Security Settings, the Users group must have User Rights Assignment “Allow log on locally”. By default, the Users group is included. If the Users group does not have this right, the following error occurs:
  
  **1385 -- Logon failure: the user has not been granted the requested logon type at this computer**.

- Backups of the SharePoint Web applications that use Granular Recovery Technology (GRT) and that contain a larger number of content databases (100+) may timeout. In this situation, increase the default “Client read timeout” setting to 900 seconds.

- Technical Support may want nbfsd logs from the media server. Use the Verbose setting carefully as the nbfsd log can grow very large.

About troubleshooting SharePoint restore operations

Note the following when you perform restores:

- NetBackup does not prevent you from restoring placeholders.
- NetBackup lets you restore any object that can hold a document, even it does not contain a document.
The following issues also exist for SharePoint 2010:

- For a SharePoint survey list, after a restore the “Time Created” value reflects the value at the time of the granular restore. This behavior is by design.
- If you restore a deleted report, the report ID is incremented upon restore. If you want to maintain the original report ID value, restore the entire report container.
- When you restore a Web application a new application pool is created for each restore. The original application also remains and can be deleted.

See Figure 9-1.

Figure 9-1 New application pool after a Web application restore

About NetBackup for SharePoint and client-side deduplication

When you use the NetBackup for SharePoint with client-side deduplication, the job details only show that deduplication occurs on the front-end Web server. The job is reported this way even if client-side deduplication is enabled for the SQL client and the other SharePoint farm hosts. (Deduplication is performed if you choose Prefer to use client-side deduplication or Always use client-side deduplication.)

The bpbrm logs contain information on the deduplication process (shown as “Client Direct”). For example, the log for a SQL back-end server is as follows:
Troubleshooting VMware backups and restores of SharePoint Server

One Application State Capture job is created per VM, regardless of which applications are selected in policy.

Note the following when you perform VMware backups that protect applications:

- If the ASC job fails, the VMware snapshot or backup continues. Application-specific data cannot be restored.
- The ASC job can result in status 1 (partially success). For example, if the Symantec VSS Provider is not installed on the VM guest. Or if SharePoint was protected, but SQL failed to be protected.
- Failure results in the discovery job or parent job exiting with status 1.
- ASC messages are filtered to the ASC job details.
- If you enable recovery for a particular application but that application does not exist on the VM, the ASC job returns Status 0.
- Details on the ASC job can be found in the Activity monitor job details.
- `bpfis` is executed and simulates a VSS snapshot backup. This simulation is required to gain logical information of the application.
Using NetBackup for SharePoint with SharePoint Server 2003

This chapter includes the following topics:

■ Limitations on SharePoint Server 2003 restores
■ About restores of SharePoint Server 2003 and Windows SharePoint Services 2.0
■ Recovering SharePoint 2003 Server (without BMR)

Limitations on SharePoint Server 2003 restores

The following limitations exist when you perform restores of SharePoint Server:

■ Redirected restores are only supported for SharePoint 2003 portals or team sites.

■ The following cannot be redirected to another SharePoint 2003 portal or team site:
  ■ Documents and folders (These items can be redirected to a file system.)
  ■ Farm Configuration database and Single Sign-on database
  ■ Index Files or Index database

■ For additional limitations, see the following:
  See “Limitations on SharePoint Server backups and restores” on page 20.
About restores of SharePoint Server 2003 and Windows SharePoint Services 2.0

Note the following when you perform restores of SharePoint Server 2003 and Windows SharePoint Services 2.0:

- Note that during a SharePoint 2003 portal recovery, a 2-minute delay occurs before the Index Files or the Index database is restored. This delay allows previously restored databases to be committed.
- You cannot restore a top-level site from a backup that uses GRT. In this case, you must restore the Content database. You can restore libraries, documents, and lists if the top-level site exists.
- For more information applicable to SharePoint Server restores, see the following topic:
  See “About restores of SharePoint Server, SharePoint Foundation, and Windows SharePoint Services” on page 79.

How the NetBackup Recovery Assistant restores SharePoint Server 2003 and Windows SharePoint Services 2.0

The NetBackup Recovery Assistant launches a restore job for each database in a SharePoint 2003 portal site or team site. Databases are restored in the proper order to ensure that a working portal exists when the restore is complete. After all the databases are restored any items you selected are restored in a single job. If a SharePoint 2003 Index database is restored or redirected with any other database, the Recovery Assistant pauses the restore process for two minutes. The pause in the restore lets the commits of the database and the portal site or team site to take effect. After the two minutes elapse, the Index database is restored.

For SharePoint 2003, the Recovery Assistant restores objects in the following order:

- Configuration databases (only if assistant is run in disaster recovery mode)
- Content databases
- Services databases
- User profile databases
- Team databases
- Index databases
- Single Sign-on databases
- Documents, lists, etc.
Objects are skipped if they are not found in the database configuration. Each restore may only restore a portion of the components depending on what objects you select and the backup image you select. When you restore an item, it does not restore an entire Content database or Document library.

**Restore options for SharePoint Server 2003 on the Microsoft SharePoint tab**

On this tab you can choose to bring databases online after a restore job. You can also specify a different location to which to redirect a SharePoint 2003 portal site or team site. The farm or the SharePoint 2003 portal site or team site to which you want to redirect the restore must already exist.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring restored databases online and reconnect previous database links</td>
<td>Select this option to bring the databases online after a restore job. This option also re-establishes the link between the restored databases and their corresponding SharePoint 2003 portals or team sites.</td>
</tr>
<tr>
<td>Release the lock on the SharePoint farm topology, if it is set.</td>
<td>Check this option to have NetBackup release the lock on the SharePoint farm topology before you run the backup or restore operation. Because another application may have locked the topology, check with your SharePoint administrator before you select this option.</td>
</tr>
<tr>
<td>Preserve existing Internet Information Services (IIS) Website and application pool.</td>
<td>This option applies to SharePoint 2007 and 2010 only.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>If versioning is enabled on the restore destination</strong></td>
<td>If versioning is enabled on the destination to which you want to restore an individual item or document, select one of the following options:</td>
</tr>
<tr>
<td>■ Add as a new version</td>
<td>NetBackup restores the existing item or document as a new version, which makes it the most recent version of the existing item. For example, assume that you have five versions of <code>testfile.doc</code> and choose to restore version 2.0 of the file. When the file is restored, it is added as <code>testfile.doc 6.0</code> and is the most recent version.</td>
</tr>
<tr>
<td>■ Skip if the item exists</td>
<td>NetBackup does not restore the item if an identical item or document exists in the restore destination. NetBackup notes that the file was skipped in the job log.</td>
</tr>
<tr>
<td>■ Restore over existing items</td>
<td>NetBackup restores the existing item as a new version and deletes the existing version. For example, assume that the version history is as follows:</td>
</tr>
</tbody>
</table>
|                                            | `testfile.doc version 3.0`  
|                                            | `testfile.doc version 2.0`  
|                                            | `testfile.doc version 1.0`  |
|                                            | `testfile.doc version 3` is the most recent version. If you choose to restore `testfile.doc version 2.0`, the restore adds `testfile.doc version 4.0` and deletes `testfile.doc version 2.0`. So the version history appears as follows: |
|                                            | `testfile.doc version 4.0`  
|                                            | `testfile.doc version 3.0`  
|                                            | `testfile.doc version 1.0`  |
|                                            | `testfile.doc version 2.0` is now version 4.0 of the file.                                                                                      |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If versioning is not enabled on the restore destination</strong></td>
<td>If versioning is not enabled on the destination to which you want to restore an individual item, select one of the following options:</td>
</tr>
<tr>
<td>■ Skip if the item exists</td>
<td>NetBackup does not restore the item if an identical item exists in the restore destination. NetBackup indicates that the file was skipped in the log.</td>
</tr>
<tr>
<td>■ Restore over existing items</td>
<td>NetBackup replaces the existing item with the restored item.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restore only the most recent version of an item</strong></td>
<td>Check this option to only restore the most recent version of an item. Note that NetBackup restores the most recent version of the versions you selected for restore. If a more recent version exists, but you did not select it for restore that version is not restored.</td>
</tr>
</tbody>
</table>
# Table 10-1  Microsoft SharePoint tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Include security information**    | Check this option to restore any applicable security information with the item. Note that security information is restored only if you select a parent folder and not when you select individual items. For example, security information is restored when you select Shared Documents, but not if you select an individual document. However, an individual object can have user permissions that are defined with a level of “limited access.” In this case, permissions for those users are not restored with that object. You can restore different levels of security based on the SharePoint item you restore:  
  - **Sites**  
    User and SharePoint Group information and security ACL are restored for top-level sites.  
  - **Subsites**  
    Security ACL is restored.  
  - **Lists**  
    Security ACL and other security-related information are restored. |
| **Redirect SharePoint Resources**   | Check this option to redirect a SharePoint 2003 portal or team site.  
  See “Redirecting a restore of a SharePoint 2003 portal site or team site” on page 140. |
| **SharePoint 2003 portal sites or SharePoint 2007 web applications** | To redirect a SharePoint 2003 portal or team site, specify the URL of the destination site and the name of the front-end Web server.  
Example URLs include the following:  
http://SharePoint 2003 portal  
http://SharePoint 2003 team site  
Indicate the host name of the Web server to which you want to redirect. The Web server must already exist on the destination location. |
| **Individual SharePoint sites, documents, lists, or items** | You can redirect documents, lists, or items to a path, as follows:  
  - **Redirect to path**  
    In the **Restore to drive or UNC path** box, enter the drive letter or UNC Path. Use the following format for a UNC path: \servername\share.  
    In the **Restore to path** box, enter the path to which you want to direct the restore.  
  - **Redirect to workspace or document library (WebStorageSystem-based only).**  
    This option only applies to SharePoint 2001 restores.  
    Note that when you direct items to a file system, any list items you selected are not restored and appear as 0-KB files. |

See “Restore options for SharePoint Server on the General tab” on page 81.
Redirecting a restore of a SharePoint 2003 portal site or team site

A SharePoint 2003 portal site can be redirected to another site in the farm. A team site can be redirected to another WSS site. The target portal site or team site where you want to redirect the restore must already exist on the specified Web server. The target portal site or team site must also have the same database structure as the source site.

Note the following when you redirect a portal or a team site:

- You can only redirect the restore of portals or team sites and these components must be restored at the database level. You can restore Configuration databases and Single Sign-on databases back to the original location only. Individual SharePoint items must be restored to their original site.

- You can redirect a restore of a portal within the same farm. The SQL database host and the SharePoint host must be the same. A redirected restore is not supported if the SQL databases exist across multiple SQL hosts.

- You must restore all SQL databases in one operation at the same time.

To redirect a restore of a SharePoint 2003 portal site or team site

1. Log on as Administrator.
2. Create the target portal site or the WSS site on the target Web server. The target site must have the same database structure as the source site.
3. Open the Backup, Archive, and Restore interface.
4. Choose File > Select Files and Folders to Restore > from Normal Backup.
5. Select the MS-SharePoint policy type.
   See "Specifying the server, client, and the policy type for a SharePoint Server restore operation" on page 80.
6. From the NetBackup History pane, select the image(s) that contain the objects you want to restore:
   - The last full backup, or
   - The last full backup and all subsequent differential backups
7. In the All Folders pane, expand Microsoft SharePoint Resources.

Note: When you select items to restore, do not check the checkbox for an item in the All folders pane. Only check the checkbox for an item in the Contents of pane.
8 In the Contents of pane, select the Web application, portal site, or team site to redirect.

9 Select Actions > Restore.

10 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

11 Select Redirect SharePoint Resources.

12 Click SharePoint 2003 portal sites or SharePoint 2007 web applications.

13 In the URL box, type the URL of the portal site or team site to which you want to redirect the restore. For example:

   http://portal
   http://team site

14 In the Front end web server name box, indicate the host name of the Web server.

   See “Restore options for SharePoint Server” on page 80.

15 Click Start Restore.

   See “Redirecting a restore of a SharePoint Web application within a farm” on page 106.

   See “Redirecting individual SharePoint items to a file path” on page 112.

Recovering SharePoint 2003 Server (without BMR)

If you do not have BMR, the general process for recovering SharePoint Server is as follows:

- Reinstall Windows and any Service Packs or Hotfixes.
- Restore System State from the backup image.
- Reinstall SharePoint Server and any Service Packs.
- Restore the Configuration database.
   When you restore the Configuration database, restore it individually and before any other object in the farm.
- Restore all SQL databases.
- Bring the Web Application(s) or portal(s) online.
- From a SharePoint front-end server, restore each Web Application or portal separately.
   The front-end server is the client name that you specified in the MS-SharePoint backup policy.
■ Wait for SharePoint to initialize storage for the Search Index. This may take a few minutes to occur, after you have started a newly recovered Web Application or portal.

■ Restore the Search Index.
A
Allow multiple data streams 67

B
backup media required 24
Backup selections list
  adding SharePoint resources 72
  adding the AllWebs directive 72
backups
  automatic 16
  backup types 69
  SharePoint backup options 77
  SharePoint objects that are included in 17–18
  user-directed 78
    overview 16
backups, automatic
  running manually 58
bpbkar log 128
bpfis log 128
bppfi log 128
Bring restored databases online and reconnect
  previous database links 81, 137

C
clients list, for backup policies 72
compatibility information 24
compression 66
Configuration database
  precautions when you restore SharePoint 80
Consistency check before backup host property 55
  consistency checks
    performing 57

D
debug logs 127–128
  debug level 130
  enabling 128
deduplication and job details 132
differential-incremental backups 69
disaster recovery
  requirements 123
    without BMR 141
Distributed Application Restore Mapping 58

E
Enable granular recovery 67
encryption 66

F
federated farms
  configuring NetBackup for 58

G
Granular Recovery Technology (GRT)
  configuring restores for multiple SharePoint hosts 58

I
IIS Default Application Pool identity 25
installation
  adding a license key 26
  requirements for NetBackup clients 25
    requirements for NetBackup servers 24
installing and configuring Network File System
  (NFS) 28

J
Java interface 49

L
license keys, adding 26

M
manual backups 16

N
nbfsd log 129
nbfsd port 44
NetBackup Client Service log on account, configuring 52
NetBackup Legacy Network Service log on account, configuring 53
NetBackup media kit 21
Network File System (NFS), described 28

P
placeholders, restoring 131
policy configuration
  adding clients 72
  attributes 66
  for databases 65
  overview 65
  schedules 67
  specifying objects to back up 72
  testing 58
Policy type for restores 80

R
raw device mapping
  and VMware 116
reports
  client 130
  media 130
  operational 130
reports, restoring 131
restores
  of individual items 94–95
  of SharePoint Server, SharePoint Foundation, or Windows SharePoint Services 85
  redirecting 19
  server-directed 19
  SharePoint 2007 restore options 80
restores, redirected
  of a Web application 106, 109
  to a file path 112
restores, using Granular Recovery Technology
  configuring storage units for 51

S
schedules
  adding 67
  frequency 68
  properties 68
Server to use for backups and restores 80

Services for NFS
  installing on Windows 2003 R2 SP2 41
SharePoint application server logon account 55
SharePoint load balancing 25
SharePoint Server
  consistency checks options 57
  properties 54
SharePoint user 25
Source client for restores 80
spsv2ra 129
survey lists, restoring 131

tar log 129
testing policy configuration 58
troubleshooting
  NetBackup debug logs 127
  status of NetBackup operations 130

U
user-directed backups 78
  SharePoint backup options 77

W
Windows interface 49